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前言

根据中华人民共和国电子信息产品污染防止管理对本产品进行了说明。

This is an explanation for the product based on “Control of pollution caused by Electronic Information Products” 
in the People’s Republic of China.
中華人民共和国での電子情報製品の汚染防止管理に基づき、製品について説明しています。

产品中有毒有害物质或元素的名称及含量

部件名称

有毒有害物质或元素

铅

Pb
汞

Hg
镉

Cd
六价铬

(Cr6+)
多溴联苯

PBB
多溴二苯醚

PBDE
LCD 显示器 × × × ○ ○ ○
印刷电路板配件 × × × ○ ○ ○
内部接线的材料 × × × ○ ○ ○
存储媒体驱动 × × × ○ ○ ○
箱体和

底座

塑料 × × × ○ ○ ○
金属 × × × ○ ○ ○

电源 × × × ○ ○ ○
操作键 × × × ○ ○ ○

附件 / 

选配件

端子用螺钉 × × × ○ ○ ○
电源线 × × × ○ ○ ○
远程控制端子
438227 × × × ○ ○ ○

安装支架
B9900BX × × × ○ ○ ○

操作面板锁定键
B8706FX × × × ○ ○ ○

CF 卡
772091,772092, 
772093,772094,
772095

× × × ○ ○ ○

CF 卡适配器
772090 × × × ○ ○ ○

分流电阻
415920,415921,
415922,438920,
438921,438922

× × × ○ ○ ○

○：表示该部件的所有均质材料中的有毒有害物质或元素的含量均低于 GB/T 26752 标准所规定的限量要求。

×：表示该部件中至少有一种均质材料中的有毒有害物质或元素的含量超过 GB/T 26752 标准所规定的限量要求。

本产品的部分部件包含 RoHS 指令中的限用物质，但是其使用方法不受该指令限制。

Some parts of this product include the restricted substances of RoHS Directive, but their applications are under the 
exemption of the directive.
この製品の一部には RoHS 指令の規制物質が含まれていますが、その使用方法は指令の適用除外となっています。

环保使用期限
该标志为环境保护使用期限，根据 SJ/T11364，适用于在中国 (台湾、香港、澳门除外 )销售的电

子电气产品。

只要您遵守该产品相关的安全及使用注意事项，在自制造日起算的年限内，则不会因产品中有害物

质泄漏或突发变异，而造成对环境的污染或对人体及财产产生恶劣影响

注）该年数为“环保使用期限”，并非产品的质量保证期。零件更换的推荐周期，请参照使用说明书

Daqstation �DX1000/DX1000N/DX2000/ 
DX1000T/DX2000T

关于产品污染防止管理
Control of Pollution Caused by the Product
製品の汚染防止管理について
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关于开放源代码软件的使用

オープンソースソフトウエアの使用について
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Heimdal
The password-management function of the following products uses Heimdal source code for AES authentication key generation. 
In accordance with the Heimdal license agreement, the copyright notice, redistribution conditions, and license are listed below.

以下产品的密码管理功能中的 AES 认证键生成部分使用 Heimdal的源代码。根据 Heimdal 的授权，用原文 ( 英文 )记述了版权、
发布条件及授权。

下記の製品のパスワード管理機能における AES認証キー生成部は、Heimdalのソースコードを使用しています。Heimdalのラ
イセンスにしたがい、コピーライト・配布条件およびライセンスを原文 ( 英文 ) にて記載します。

DX1002, DX1004, DX1006, DX1012, DX1002N, DX1004N, DX1006N, DX1012N, DX2004, DX2008, DX2010, DX2020, DX2030, 
DX2040, DX2048, DX1002T, DX1004T, DX1006T, DX1012T, DX2004T, DX2008T, DX2010T, DX2020T, DX2030T, DX2040T, 
DX2048T, DXA120(DAQSTANDARD)

Copyright (c) 2006 Kungliga Tekniska Högskolan (Royal Institute of Technology, Stockholm, Sweden).All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

1.	 Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2.	 Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following  
	 disclaimer in the documentation and/or other materials provided with the distribution.

3.	 Neither the name of the Institute nor the names of its contributors may be used to endorse or promote products derived  
	 from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE INSTITUTE AND CONTRIBUTORS "AS IS'' AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE INSTITUTE OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, 
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Expat
The report template function of the following products uses Expat source code for report creation. In accordance with the 
Heimdal license agreement, the copyright notice, redistribution conditions, and license are listed below.

以下产品的报表模版功能中的创建报表部分使用 Expat 的源代码。根据 Expat 的授权，用原文（英文）记述了版权、发布条件及授权。

以下の製品の帳票テンプレート機能における帳票作成部では、Expat のソースコードを使用しています。Expat のライセンスに
したがい、コピーライト・配布条件およびライセンスを原文 ( 英文 ) にて記載します。

DX1002, DX1004, DX1006, DX1012, DX1002N, DX1004N, DX1006N, DX1012N, DX2004, DX2008, DX2010, DX2020, DX2030, 
DX2040, DX2048, DX1002G, DX1004G, DX1006G, DX1012G, DX1002T, DX1004T, DX1006T, DX1012T, DX2004T, DX2008T, 
DX2010T, DX2020T, DX2030T, DX2040T, DX2048T

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files 
(the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do 
so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, 
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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MD5
The following products uses MD5 source code. In accordance with the MD5 license agreement, the copyright notice, 
redistribution conditions, and license are listed below.

以下の製品は、MD5のソースコードを使用しています。MD5のライセンスにしたがい、コピーライト・配布条件およびライ
センスを原文（英文）にて記載します。

以下产品使用的是 MD5 的源代码。根据 MD5 的授权，用原文 (英文 )记述了版权、发布条件及授权。

DX1002, DX1004, DX1006, DX1012, DX1002N, DX1004N, DX1006N, DX1012N, DX2004, DX2008, DX2010, DX2020, DX2030, 
DX2040, DX2048, DX1002T, DX1004T, DX1006T, DX1012T, DX2004T, DX2008T, DX2010T, DX2020T, DX2030T, DX2040T, 
DX2048T

• RSA Data Security’s MD5 License

RSA Data Security, Inc., MD5 message-digest algorithm

Copyright (C) 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved.

License to copy and use this software is granted provided that it is identified as the "RSA Data Security, Inc. MD5 Message-
Digest Algorithm" in all material mentioning or referencing this software or this function.

License is also granted to make and use derivative works provided that such works are identified as "derived from the RSA Data 
Security, Inc. MD5 Message-Digest Algorithm" in all material mentioning or referencing the derived work.

RSA Data Security, Inc. makes no representations concerning either the merchantability of this software or the suitability of this 
software for any particular purpose. It is provided "as is" without express or implied warranty of any kind.

These notices must be retained in any copies of any part of this documentation and/or software.
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Introduction
Thank you for purchasing the Daqstation DX2000 (DX).This 
manual describes the basic operating procedures and installation 
and wiring procedures of the DX2000. To ensure correct use, 
please read this manual and the manuals below thoroughly before 
beginning operation.
For the product specifications, see the general specifications.

	 Paper Manual
Manual Title Manual No.*

DX2000 Operation Guide IM 04L42B01-02E
This manual. 

Control of Pollution Caused by the Product IM 04L41B01-91C
Gives a description of pollution control.

About the Usage of Open Source Software IM 04L41B01-81Z1

	 DAQSTANDARD
Download the DAQSTANDARD (Application software) from the 
following URL.
URL: https://www.yokogawa.com/ns/dxadv/download/

	 Electronic Manuals
User's manuals for the DX are available on the following web site:

	 http://www.yokogawa.com/ns/dxadv/im/
You need Adobe Reader 7.0 or later (but the latest version is 
recommended) installed on the computer in order to open and read 
the manuals.
Manual Title Manual No.*

DX2000 Operation Guide IM 04L42B01-02E
This is the electronic version of the paper manual.

DX2000 User’s Manual IM 04L42B01-01E
Describes how to use the DX2000. The communication and 
network functions, custom display functions, and some of the 
options are excluded.

DX1000/DX1000N/DX2000 
Multi Batch (/BT2) User’s Manual

IM 04L41B01-03E

Describes how to use the multi batch function (/BT2 option).
DX1000/DX1000N/DX2000 Custom  
Display User’s Manual

IM 04L41B01-04E

Describes how to use the custom display function.
DX1000/DX1000N/DX2000 Advanced 
Security Function (/AS1) User’s Manual

IM 04L41B01-05EN

Describes how to use the advanced security function  
(/AS1 option).

DX1000/DX1000N/DX2000 IM 04L41B01-17E
Communication Interface User’s Manual

Describes how to use the communication functions using the 
Ethernet and serial interfaces.

DX1000/DX1000N/DX2000  
PLC Communication Protocol
Communication Interface User’s Manual

IM 04L41B01-18E

Describes how to use communication functions through the 
PLC communication protocol interface.

DX1000/DX1000N/DX2000  
PROFIBUS-DP (/CP1) Communication 
Interface User’s Manual

IM 04L41B01-19E

Describes how to use communication functions through the 
PROFIBUS-DP interface (/CP1 option).

The electronic manual (CD, part no. B8706ZZ) is available for 
purchase. Please contact your nearest YOKOGAWA dealer for 
details.

	 DAQSTANDARD Manuals
Manual Title Manual No.*

DAQSTANDARD Viewer User’s Manual IM 04L41B01-63EN
DAQSTANDARD Hardware Configurator 
User’s Manual

IM 04L41B01-64EN

DAQSTANDARD DX-P Hardware 
Configurator User’s Manual

IM 04L41B01-65EN

Installing DAQSTANDARD IM 04L41B01-66EN

	 General Specifications (GS)
General Specifications Name General Specifications No.*

Daqstation DXAdvanced 
DX2000 

GS 04L42B01-01E

*	 The last characters, "EN" for example, of the manual number 
and general specifications number indicates the language in 
which the manual is written.

Notes
•	 The contents of this manual are subject to change without 

prior notice as a result of continuing improvements to the 
instrument’s performance and functions.

•	 Every effort has been made in the preparation of this manual 
to ensure the accuracy of its contents. However, should you 
have any questions or find any errors, please contact your 
nearest YOKOGAWA dealer.

•	 Copying or reproducing all or any part of the contents of this 
manual without YOKOGAWA’s permission is strictly prohibited.

•	 The TCP/IP software of this product and the document 
concerning the TCP/IP software have been developed/
created by YOKOGAWA based on the BSD Networking 
Software, Release 1 that has been licensed from the Regents 
of the University of California

Authorised Representative in the EEA
The Authorised Representative for this product in the EEA is:
	 Yokogawa Europe B.V.
	 Euroweg 2, 3825 HD Amersfoort,The Netherlands

QR Code
The product has a QR Code pasted for efficient plant maintenance 
work and asset information management.
It enables confirming the specifications of purchased products and 
user’s manuals.
For more details, please refer to the following URL.
https://www.yokogawa.com/qr-code

QR Code is a registered trademark of DENSO WAVE 
INCORPORATED.

Trademarks
•	 DAQSTATION, Daqstation, and DXAdvanced are registered 

trademarks of Yokogawa Electric Corporation.
•	 Microsoft and Windows are registered trademarks or trademarks 

of Microsoft Corporation in the United States and/or other 
countries.

•	 Adobe and Acrobat are registered trademarks or trademarks of 
Adobe Systems Incorporated.

•	 Kerberos is a trademark of the Massachusetts Institute of 
Technology (MIT).

•	 Company and product names that appear in this manual are 
registered trademarks or trademarks of their respective holders.

•	 The company and product names used in this manual are not 
accompanied by the registered trademark or trademark symbols 
(® and ™).

 

12th Edition: June 2020 (YK)
All Rights Reserved, Copyright © 2005, Yokogawa Electric Corporation
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Safety Precautions
•	� This instrument conforms to IEC safety class I (provided with 

terminal for protective grounding), Overvoltage Category II or I*1, 
Pollutuin Degree 2, and Measurement Category II (CAT II)*2.

	 *1	� Overvoltage Category II : Applied to standard power supply 
(100-240 VAC), I: Applied to /P1 option (24 VDC/AC)

	 *2	� Measurement Category II (CAT II) applies to measuring 
circuits connected to low voltage installation, and electrical 
instruments supplied with power from fixed equipment such 
as electric switchboards.

•	� This instrument is an EN61326-1 (EMC standard) class A 
instrument (for use in commercial, industrial, or business 
environments). The influence rate (judgment condition A) in the 
immunity test environment is within ±10 % of the range or ±10 
mV (50V range only, ±20 % of the range).

•	� The general safety precautions described here must be 
observed during all phases of operation. If the DX is used in a 
manner not described in this manual, the DX safety features may 
be impaired. Yokogawa Electric Corporation assumes no liability 
for the customer’s failure to comply with these requirements.

•	 The DX is designed for indoor use.

•	 About This Manual
•	 Please pass this manual to the end user. We also ask you to 

store this manual in a safe place.
•	 Read this manual thoroughly and have a clear understanding of 

the product before operation.
•	 This manual explains the functions of the product. It does not 

guarantee that the product will suit a particular purpose of the user.
•	 Precautions Related to the Protection, Safety, and Alteration of 

the Product
The following safety symbols are used on the product and in this manual.

“Handle with care.”  To avoid injury and damage to 
the instrument, the operator must refer to the 
explanation in the manual.

Protective ground terminal

Functional ground terminal (do not use this terminal 
as a protective ground terminal.)

Alternating current

Direct current

ON (power)

OFF (power)

•	 For the protection and safe use of the product and the system in 
which this product is incorporated, be sure to follow the instructions 
and precautions on safety that are stated in this manual whenever 
you handle the product. Take special note that if you handle the 
product in a manner that violates these instructions, the protection 
functionality of the product may be damaged or impaired. In such 
cases, YOKOGAWA does not guarantee the quality, performance, 
function, and safety of product.

•	 When installing protection and/or safety circuits such as lightning 
protection devices and equipment for the product and control 
system or designing or installing separate protection and/or safety 
circuits for fool-proof design and fail-safe design of the processes 
and lines that use the product and the control system, the user 
should implement these using additional devices and equipment.

•	 If you are replacing parts or consumable items of the product, 

make sure to use parts specified by YOKOGAWA.
•	 This product is not designed or manufactured to be used in 

critical applications that directly affect or threaten human lives. 
Such applications include nuclear power equipment, devices 
using radioactivity, railway facilities, aviation equipment, air 
navigation facilities, aviation facilities, and medical equipment. 
If so used, it is the user’s responsibility to include in the system 
additional equipment and devices that ensure personnel safety.

•	 Do not modify this product.

	 WARNING

	 •	 Use the Correct Power Supply
	 Ensure that the source voltage matches the voltage of the power 

supply before turning ON the power. In the case of a desktop 
type, ensure that it is within the maximum rated voltage range of 
the provided power cord before connecting the power cord.

	 •	 Use the Correct Power Cord and Plug (Desktop Type)
	 To prevent electric shock or fire, be sure to use the power cord 

supplied by YOKOGAWA. The main power plug must be plugged into 
an outlet with a protective earth terminal. Do not disable this protection 
by using an extension cord without protective earth grounding. 

	 The power cord is designed for use with this instrument. Do not 
use the power cord with other instruments.

	 •	 Connect the Protective Grounding Terminal
	 Make sure to connect the protective grounding to prevent 

electric shock before turning ON the power.
	 The power cord that comes with the desktop type is a three-

prong type power cord. Connect the power cord to a properly 
grounded three-prong outlet.

	 •	 Do Not Impair the Protective Grounding
	 Never cut off the internal or external protective grounding wire or 

disconnect the wiring of the protective grounding terminal. Doing 
so invalidates the protective functions of the instrument and 
poses a potential shock hazard.

	 •	 Do Not Operate with Defective Protective Grounding
	 Do not operate the instrument if the protective grounding might 

be defective. Also, make sure to check them before operation.
	 •	 Do Not Operate in an Explosive Atmosphere

	 Do not operate the instrument in the presence of flammable 
liquids or vapors. Operation in such an environment constitutes 
a safety hazard.

	 Prolonged use in a highly dense corrosive gas (H2S, SOx, etc.) 
will cause a malfunction.

	 •	 Do Not Remove Covers
	 The cover should be removed by YOKOGAWA’s qualified 

personnel only. Opening the cover is dangerous, because some 
areas inside the instrument have high voltages.

	 •	 Ground the Instrument before Making External Connections
	 Connect the protective grounding before connecting to the item 

under measurement or control unit.
	 •	 Damage to the Protection

	 Operating the instrument in a manner not described in this 
manual may damage the instrument’s protection.

	 CAUTION

	 This instrument is a Class A product. Operation of this instrument 
in a residential area may cause radio interference, in which case 
the user is required to take appropriate measures to correct the 
interference.

•	 Exemption from Responsibility
•	 YOKOGAWA makes no warranties regarding the product except 

those stated in the WARRANTY that is provided separately.
•	 YOKOGAWA assumes no liability to any party for any loss 

or damage, direct or indirect, caused by the user or any 
unpredictable defect of the product.
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•	 Handling Precautions of the Software
•	 YOKOGAWA makes no warranties regarding the software 

accompanying this product except those stated in the 
WARRANTY that is provided separately.

•	 Use the software on a single PC.
•	 You must purchase another copy of the software, if you are to 

use the software on another PC.
•	 Copying the software for any purposes other than backup is 

strictly prohibited.
•	 Please store the original media containing the software in a safe place.
•	 Reverse engineering, such as decompiling of the software, is 

strictly prohibited.
•	 No portion of the software supplied by YOKOGAWA may be 

transferred, exchanged, or sublet or leased for use by any third 
party without prior permission by YOKOGAWA.

Handling Precautions of the DX
•	 Use care when cleaning this instrument, especially its plastic 

parts. Use a soft dry cloth. Do not use organic solvents, such 
as benzene or thinner, or other cleansers. They may cause 
discoloring and deformation.

•	 Keep electrically charged objects away from the signal terminals. 
If you do, the DX may malfunction.

•	 Do not apply volatile chemicals to the display, panel keys, etc. 
Do not allow rubber and vinyl products to remain in contact 
with the DX for long periods of time. If you do, the DX may 
malfunction.

•	 When not in use, make sure to turn OFF the power switch.
•	 If there are any symptoms of trouble such as strange odors or 

smoke coming from the DX, immediately turn OFF the power 
switch and the power supply source. Then, contact your nearest 
YOKOGAWA dealer.

Handling Precautions of the External Storage 
Medium (CF Card)

•	 Use caution in the handling of the external storage medium as it 
is a delicate product.

•	 Write operation to storage media may fail under high-temperature 
or low-temperature environments. If you are using the DX in a 
low-temperature environment (around 10°C or less), use the DX 
after the warm-up time (at least 30 minutes) has elapsed. If you 
are using the DX under a high-temperature environment (around 
40°C or more), it is recommended that the external storage 
medium be inserted into the drive when saving the data and be 
removed after the data storage operation is finished.

•	 Remove the storage medium from the drive when turning the DX 
ON/OFF.

•	 Touching the compact flash section when static electricity is built 
up on the human body can lead to erroneous operation.

•	 For the general handling precautions of the external storage 
medium, see the instruction manual that came with the external 
storage medium.

	 CAUTION

•	 Do not eject the external storage medium while the access 
indicator is illuminated. This can damage the data.

•	 Do not access the storage medium in a place with vibrations or 
shock. The storage medium or drive may malfunction.

Checking the Contents of the Package
Unpack the box and check the contents before operating the 
instrument. If some of the contents are not correct or missing or 
if there is physical damage, contact the dealer from which you 
purchased them.

	 DX2000
A name plate is located on the top panel of the DX (side panel on 
models with the /H5[ ] option). Check that the model name and 
suffix code given on the name plate match those on your order.

Name plate

SUFFIX

SUPPLY
FREQUENCY
NO.

STYLE
H SMODEL

	 NO. (Instrument Number)
When contacting the dealer from which you purchased the 
instrument, please give them the instrument number.

	 MODEL and SUFFIX Code

Model Suffix Code Optional 
code Description

DX2004 Daqstation DX2000 4ch, 125 ms (Fast sampling mode 25 ms)

DX2008 Daqstation DX2000 8ch, 125 ms (Fast sampling mode 25 ms)

DX2010 Daqstation DX2000 10ch, 1 s (Fast sampling mode 125 ms)

DX2020 Daqstation DX2000 20ch, 1 s (Fast sampling mode 125 ms)

DX2030 Daqstation DX2000 30ch, 1 s (Fast sampling mode 125 ms)

DX2040 Daqstation DX2000 40ch, 1 s (Fast sampling mode 125 ms)

DX2048 Daqstation DX2000 48ch, 1 s (Fast sampling mode 125 ms)

Internal memory 

size

-3 Standard memory (400 MB)

External storage media -4 With CF card

Language -2 English/German/French, deg F, and DST

Options /A1 Alarm output 2 points*1

/A2 Alarm output 4 points*1*9

/A3 Alarm output 6 points*1

/A4 Alarm output 12 points*1*8*9

/A5 Alarm output 24 points*1*2*7*9

/C2 RS-232 interface*3

/C3 RS-422/485 interface*3

/D5 VGA output

/F1 FAIL/status output*2*4*8

/F2 FAIL + alarm output 22 points*1*4*7*9

/H2 Clamped input terminal (detachable)

/H5[ ] Desktop type*5

/M1 Mathematical functions (including the report function)*9

/N1 Cu10, Cu25 RTD input/3 leg isolated RTD

/N2 3 leg isolated RTD*6

/N3 Extended input type (PR40-20, Pt50, etc.)

/P1 24 VDC/AC power supply*5

/R1 Remote control*9

/TPS4 24-VDC transmitter power supply (4 loops)*7

/TPS8 24-VDC transmitter power supply (8 loops)*7*8*9

/USB1 USB interface

/PM1 Pulse input (including remote control and �mathematical 

function)*9

/CC1 Calibration correction function

/MC1 External input function*10

/BT2 Multi batch function*11

/CP1 PROFIBUS-DP*3

/AS1 Advanced security function

*1	 /A1, /A2, /A3, /A4, /A5, and /F2 cannot be specified together.
*2	 /A5 and /F1 cannot be specified together.
*3	 /C2, /C3, and /CP1 cannot be specified together.
*4	 /F1 and /F2 cannot be specified together.
*5

	

/H5[ ]
   D: Power cord UL, CSA st’d
   F: Power cord VDE st’d
   R: Power cord SAA st’d
   J: Power cord BS st’d
  H: Power cord GB st’d
  Null (/H5): Only for /P1 model (without power cord)

*6	 /N2 can be specified only for DX2010, DX2020, DX2030, DX2040 and DX2048.
*7	 /TPS4, /TPS8, /A5 and /F2 cannot be specified together.
*8	 If /TPS8 is specified, /A4 and /F1 cannot be specified together.
*9	 If /PM1 is specified, /A5, /F2, /M1, and /R1 cannot be specified together.
	 The combination of /A2/F1 and the combination of /A4/TPS8 cannot be specified together.
*10	 /MC1 can be specified only for the DX2010, DX2020, DX2030, DX2040, and DX2048.
*11	 /BT2 can only be specified for the DX2010, DX2020, DX2030, DX2040, and DX2048.
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	 Standard Accessories
The standard accessories below are supplied with the instrument. 
Check that all contents are present and undamaged.

1 2

43

32MB

5. One of these power cord types is supplied 
according to the instrument’s suffix code

/H5F/H5D /H5R

/H5H/H5J

No. Name Part Number/ 
Model

Qty. Notes

1 Mounting brackets B9900BX 2 For panel mounting 
Except for the /H5[ ] 
models.

2 Door lock key B8706FX 2 –
3 DX2000 Operation 

Guide (this manual)
IM 04L42B01-02E 1 A4 size

Control of Pollution 
Caused by the 
Product

IM 04L41B01-91C 1

About the Usage 
of Open Source 
Software

IM 04L41B01-81Z1 1

4 CF card B8706NQ 1 128 MB (The size and 
model may change.)

5 Power cord A1006WD 1 Supplied only for 
models with the /H5D 
option. Maximum 
rated voltage: 125 V

A1009WD 1 Supplied only for 
models with the /H5F 
option. Maximum 
rated voltage: 250 V

A1024WD 1 Supplied only for 
models with the /H5R 
option. Maximum 
rated voltage: 250 V

A1054WD 1 Supplied only for 
models with the /H5J 
option. Maximum 
rated voltage: 250 V

A1064WD 1 Supplied only for 
models with the /H5H 
option. Maximum 
rated voltage: 250 V

	 Optional Accessories (Sold Separately)
The following optional accessories are available for purchase 
separately. If you make an order, make sure that all contents 
are present and undamaged. For information about ordering 
accessories, contact the dealer from which you purchased the DX.

No. Name Model Minimum Notes
Q’ty

1 CF card 772093 1 512 MB
772094 1 1 GB
772095 1 2 GB

2 Shunt resistor 415920 1 250 Ω ± 0.1%
(for screw input terminal) 415921 1 100 Ω ± 0.1%

415922 1 10 Ω ± 0.1%
3 Shunt resistor

(for clamped input 
terminal)

438920 1 250 Ω ± 0.1%
438921 1 100 Ω ± 0.1%
438922 1 10 Ω ± 0.1%

4 Mounting brackets B9900BX 2 –
5 Door lock key B8706FX 1 –
6 Remote control terminal 438227 1 Remote 

controller
7 Validation document – 1 Electronic file

Style number, release number, and firmware 
version number of the DX2000

Style number:	 This is the DX2000 hardware number that is 
indicated on the name plate.

Release number:	 This is the DX2000 firmware number that is 
indicated on the name plate. The number 
corresponds to the integer part of the firmware 
version number.

Example: �If the firmware version number is 2.01, the release 
number is 2.

Firmware version number: This number is displayed on the DX2000 
system information screen. For the procedure, 
see section 2.5, “Viewing the DX Information” in 
the DX2000 User’s Manual (IM 04L42B01-01E).

MODEL

FREQUENCY
NO.

SUFFIX

SUPPLY

STYLE
H
2 2

S

Style number
Release number
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	 CAUTION

Calls attentions to actions or conditions that could cause light 
injury to the user or damage to the instrument or user’s data, and 
precautions that can be taken to prevent such occurrences.

	 Note
Calls attention to information that is important for proper operation 
of the instrument.

	
Indicates after this mark reference to related procedure or 
explanation.
	 Bold characters
Indicates character strings that appear on the screen and the 
operation keys.

Revision History
The contents of this manual corresponds to the DX with release 
number 4 and style number 5. For details on the functions that 
have been added or changed, see “DX’s Version and Functions 
Described in This Manual” in the DX2000 User’s Manual (IM 
04L42B01-01E).

Edition DX Description
2 Version 1.11 Additions and improvements to 

functionality.Version 1.21
3 Release number 2

(Version 2.0x)
Additions and improvements to 
functionality.

Style number 2 NEMA4 compliance.
4 Same as edition 3 Additions and improvements to 

functionality.
Changed the direction of the 
clamp input terminal (/H2 option).

5 Release number 3
(Version 3.0x)

Additions and improvements to 
functionality.

Style number 3 Changed the boot ROM.
6 Release number 4 

(version 4.0x)
Additions and improvements to 
functionality. Internal memory 
suffix code -3 has been added, 
and -1 and -2 have been removed.

Style number 3

7 Same as edition 6 Additions and improvements to 
explanations.

8 Release number 4 
(version 4.0x)

Additions and improvements to 
explanations. NLF is supported. 
User’s manuals are supplied by 
downloading them on the web 
site.

Style number 4 An LCD with LED back light 
replaced an LCD with CFL back 
light.

9 Same as edition 8 Merge the manuals (IM 
04L41B01-91C, IM 04L41B01-
81Z1).

10 Same as edition 9 Changes of "Proper Disposal of 
This Product"

11 Same as edition 10 Additions and improvements to 
explanations.

12 Release number 4 
(version 4.2x)
Style number 5

Changed the style (H).
Changed the EtherNet/IP name.

Protection of Environment
	 Control of Pollution Caused by the Product

For details, see the Control of Pollution Caused by the Product 
(IM04L41B01-91C).

	 Proper Disposal of This Product
This is an explanation of how to dispose of this product based on 
Waste Electrical and Electronic Equipment (WEEE), Directive. This 
directive is only valid in the EU.
•	 Marking
	 This product complies with the WEEE Directive marking 

requirement. This marking (see below) indicates that you 
must not discard this electrical/electronic product in domestic 
household waste.

	

•	 Product Category
	 With reference to the equipment types in the WEEE directive, 

this product is classified as a “Small equipment” product.
	 Do not dispose in domestic household waste. When disposing 

products in the EU, contact your local Yokogawa Europe B.V. 
office.

	 How to Replace and/or Dispose the Batteries
This is an explanation about the new EU Battery Directive 
(DIRECTIVE 2006/66/EC). This directive is only valid in the EU.
	 Batteries are included in this product. Batteries incorporated 

into this product cannot be removed by yourself. Dispose them 
together with this product. When you dispose this product in 
the EU, contact your local Yokogawa Europe B.V.office. Do not 
dispose them as domestic household waste.

	 Battery type: Lithium battery

	

	 Notice: The symbol (see above) means they shall be sorted out 
and collected as ordained in ANNEX II in DIRECTIVE 2006/66/
EC.

Conventions Used in This Manual
•	 This manual covers information regarding DX2000s that have a 

suffix code for language “-2” (English).
•	 For details on how to set the language, see section 2.6, 

“Changing the Language” in the DX2000 User’s Manual (IM 
04L42B01-01E).

	 Unit
K:	Denotes 1024. Example: 768 KB (file size)
k:	 Denotes 1000.

The following markings are used in this manual.

				  

Improper handling or use can lead to injury to the user or damage 
to the instrument. This symbol appears on the instrument to 
indicate that the user must refer to the user’s manual for special 
instructions. The same symbol appears in the corresponding place 
in the user’s manual to identify those instructions. In the manual, 
the symbol is used in conjunction with the word “WARNING” or 
“CAUTION.”
	 WARNING

Calls attention to actions or conditions that could cause serious or 
fatal injury to the user, and precautions that can be taken to prevent 
such occurrences.
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Introduction to Functions

Measured Items
You can connect DC voltage, thermocouple, RTD, and ON/OFF input and measure 
various values such as temperature and flow rate. The DX samples the input signals at 
the scan interval to obtain the measured values. The fastest scan interval is 25 ms on 
the DX2004 and DX2008 and 125 ms on the DX2010, DX2020, DX2030, DX2040, and 
DX2048.
Up to four alarm conditions can be set for each measurement channel.

Data Storage Function
There are two methods of recording measured data. One is to record the measured data 
continuously, and the other is to record only when certain events occur such as alarms. 
The measured data is recorded to the internal memory at a specified interval. The data in 
the internal memory can be stored to a CF card automatically or manually. By connecting 
to a network via the Ethernet interface, the measured data can also be automatically 
transferred to an FTP server on a network.

		

DX

Measurement input

Ethernet
Automatic data transfer to an FTP server

CF card

FTP server

Internal memory

Display Function
Measured data can be displayed as trends, numeric values, and bar graphs for each 
group. In addition, the overview display can be used to display and monitor all channels 
on a single screen.

		

Trend display Numeric (digital) display Overview displayBar graph display

Other Functions
Computation Function (option) Various types of computation can be performed by 

assigning equations to computation channels.
FAIL/status output function (option) Outputs an alarm when the DX fails. The function 

also monitors the DX status such as the remaining 
amount of internal memory and outputs alarms.

Remote control function (option) A specified action is executed when a remote input 
signal is applied to the terminal on the rear panel.

Security function Enables only registered users can operate the 
DX. The function can also be used to prohibit key 
operation.

Communication function The Ethernet interface can be used to monitor the 
DX using a Web browser and transmit e-mail when 
an event occurs such as an alarm. In addition, 
data of devices on the network can be loaded and 
displayed using the Modbus protocol.

DAQSTANDARD
The software program, DAQSTANDARD, can be used to display the measured data, 
convert the measured data format, and create DX setup data.
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DX System Configuration
The DX can be used to configure a system as shown below.
Referenced sections are of the DX2000 User’s Manual.
Referenced pages are of this manual.

Ethernet

USB port*

Alarm output*
Sec 3.5-3.8

Transmitter power supply*
Page 61

PC

DX2000

RecorderTemperature 
controller

FAIL/status output*
Sec. 2.9

USB flash memory
 Sec. 2.12

Keyboard
 Sec. 2.11

Monitor*
     Page 62

Measurement
 input

Sec. 3.3

Pulse input*
Sec. 3.10

Remote input*
     Sec. 7.1

Remote Terminal*
 Sec. 2.10

CF card
 Page 24

Keys

Communication Interface User’s Manual
PLC Communication Protocol 
Communication Interface User’s  Manual
PROFIBUS-DP Communication Interface User’s Manual

PLC (programmable
logic controller) 

PLC communication 
protocol†

Serial 
communication*

RS-232, RS-422/485, or PROFIBUS-DP*†

PLC

PC

Sec. 2.11
Barcode reader†

*: Option
†: Release number 3 or later

Terminology
•	 Memory sample
	 The operation of recording measured data.
•	 Memory start
	 The operation of starting memory sampling.
•	 Memory stop
	 The operation of stopping memory sampling.
•	 Display data
	 The waveform data shown on the DX display. The data recorded at the sampling 

interval for the displayed data.
•	 Event data
	 Measured data recorded at a sampling interval separate from that of the display data.

Introduction to Functions
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Names of Parts

Front View

POWER

CF CARDUSB

Key panel opened

Front cover opened

LCD
Display various operation 
displays such as the trend 
display as well as setup 
displays.

Power indicator
Illuminates in red when the 
power is turned ON. Illuminates 
in green while memory 
sampling is in progress.

Power switch

USB port
A USB port conforming to Rev. 
1.1.

Remote control sensor
(/KB1 and /KB2 options)
Receives infrared light from the 
remote control terminal.

Front cover (Key  panel)
Open the front cover by pulling 
the cover while holding down 
the tab at the center of the 
upper section of the cover.

CF card slot

CF card access indicator

CF card eject button
Used when ejecting the CF 
card.

Key panel cover
Open the cover by pinching the 
left tab and pulling forward.

Label (front of the key panel cover)
Write arbitrary labels for your 
convenience.

Door lock key (included)
Insert the pin in the left hole to lock.
Insert the pin in the right hole to unlock.

When closing the front cover, press 
the front cover in until the tab at the 
center of the upper section of the 
cover is all the way up. If the front 
cover is not closed completely, the 
water and dust proof capability may 
be impaired.

CAUTION

Lock key
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Rear Panel

VGA output connector
(/D5 option)
A connector for an 
external monitor.

Ethernet port
A 10Base-T port.

USB port (/USB1 option)
A USB port conforming to 
Rev. 1.1.

Optional terminals (/A[ ], /F[ ], 
/R1, /TPS[ ], and /PM1 options)
Connect optional input/output 
signal wires.

Serial interface port
(/C3 option)
A RS-422A/485 interface 
connector.

Serial interface port 
(/C2 option)
A RS-232 interface 
connector.

Input terminals (screw terminals 
or clamped terminals (/H2 option))
Connect input signal wires from the 
measured item.

Power supply terminal and 
protective earth terminal.

PROFIBUS-DP port 
(/CP1 option)
PROFIBUS connector.

Desktop Type (/H5[ ] Option)

Power connectorHandle

Feet

Functional ground terminal

Names of Parts
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DX2000 Workflow

When using the DX for the first time, carry out the following procedure.

		

Installation

Wiring

Power ON

Environmental 
Settings

Functional 
Settings

Measurement

Data 
Management

Install the DX.
 Page 49 and subsequent pages

Connect input/output wires to the terminals and connectors on the 
rear panel, and connect the power cord. 
 Page 52 and subsequent pages

Turn the power ON.
   Page 13

Set the date/time, load the CF card, and so on.
    Page 18 and 24

Set measurement functions.
    Page 19 and subsequent pages, page 28 and subsequent pages

Start the measurement.  Perform operations such as switching the 
screen and writing messages.  Save the measured data. 
   Page 39 and subsequent pages

Check and manage the measured data.
Use the software program, DAQSTANDARD, to  display 
the measured data and convert the measured data to Excel, Lotus, and 
ASCII formats. 
 Page 48
    DAQSTANDARD Viewer User’s manual (IM 04L41B01-63EN)

On a DX with advanced security (/AS1 option; release number 4 or later), carry out the 
following procedure after turning the DX on.

		

User 
Registration

Environmental 
Settings

Functional 
Settings

Measurement

Data 
Management

CF Card 
Insertion

Register the users who will operate the DX.
 Advanced Security Function (/AS1 option) User’s Manual
(IM04L41B01-05EN)

Check the measured data, and attach approval information 
to the measured data file.
 Advanced Security Function (/AS1 option) User’s Manual
(IM04L41B01-05EN)
You can also attach approval information to the measured data file 
by using the software program, DAQSTANDARD.
  DAQSTANDARD Viewer User’s Manual (IM 04L41B01-63EN)

Set the date/time.
 Page 18

Insert a CF card into the DX.
 Page 24

Set measurement functions.
 Page 19 and subsequent pages, page 28 and subsequent pages

Start the measurement. Perform operations such as switching 
the screen and writing messages. Save the measured data.
 Page 39 and subsequent pages
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Turning the Power ON/OFF

Turning the Power ON

	 CAUTION
Before turning ON the power switch, check that
•	 The power cord/wires are connected correctly to the DX.
•	 The DX is connected to the correct power supply (see page 64).
If the input wires are connected in parallel with other devices, do not turn ON/OFF	
the power switch of the DX or another device during operation. This can have 
adverse effects on the measured values.

1. 	 Open the operation cover.
2. 	 Turn ON the power switch.
	 After performing a self-test for a few seconds, the operation screen appears.

					   

3. 	 Close the operation cover.

	 CAUTION
•	� If nothing is displayed when the power switch is turned ON, turn OFF the 	

power switch and check the points listed above one more time. After checking 
the points, turn ON the power switch again. If the DX still does not work, it is 
probably a malfunction. Contact your nearest YOKOGAWA dealer for repairs.

•	� If an error message is displayed on the screen, take measures according to the 
description in chapter 11, “Troubleshooting” in the DX2000 User’s Manual.

•	� Turn ON the power switch, let the DX warm up for at least 30 minutes, and then 
start the measurements.

Turning the Power OFF

	 CAUTION
Before turning OFF the power switch, check that the external storage medium is 
not being accessed.

1. 	 Open the operation cover.

2. 	 Turn OFF the power switch.

3. 	 Close the operation cover.
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Basic Operation

Panel Keys

LCD

Key panel

Soft keys
Selects the menu that is 
displayed at the bottom of the 
screen.

START/STOP key
Memory start/stop.

ESC key
Cancels an operation.

USER key
Executes the assigned 
operation.

Favorite key
Displays the operation screen (up to 
eight screens) that are registered to 
the key.

MENU key
Switches between the operation 
mode and setting mode.

FUNC key
• Displays the soft key menu in operation mode.
• Hold down this key at least 3 s in the setting mode to switch from the setting 
 mode to the basic setting mode.

DISP/ENTER key and four arrow 
keys (up, down, left, and right)
Switches the operation screen. 
Selects and enters setup items.

DISP/ENTER key

Up arrow key

Right arrow key

Down arrow key

Left arrow key
Character/Number input keys
Enters characters and numbers.

Display

	

Status display section
Shows the display name, date/time, data 
recording, alarm icon, etc.

Data display section
Shows the measured data and the functional setup 
display.
For the waveform display and numeriuc display, see 
section 4.2, in the DX2000 user’s Manual (IM 
04L42B01-01E). For details on how to set the scale, 
see section 5.7, in the DX2000 user’s Manual (IM 
04L42B01-01E).

ScaleWaveform display Numeric display
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Display on the Status Display Section
The following information is displayed in the status display section.

Memory sampling status

Error in internal memory.
Contact your nearest YOKOGAWA dealer for repairs.

The status assigned to the status output 
(/F1 or /F2 option) is occurring.

CF card icon

Keys are locked.

E-mail transmission is enabled.

White icon: Computation in progress

Yellow icon: Computation dropout occurred

The green level display indicates the amount of 
CF card used.  If Media FIFO* is not enabled and 
the free space on the CF card falls below 10%, 
the level indicator changes to red.
* See section 1.4, in the DX1000/DX1000N User’s
 Manual. Media FIFO is a function available on 
 release number 2 or later.

If the “batch number-lot number” exceeds 20 
characters, the “date and time” position is used to 
display the “batch number-lot number.”

Memory sampling icon

Memory sampling 
stopped

Memory sampling 
in progress

Batch name (shown alternately 
with the display name)

Name of the user logged in

Batch name (shown alternately 
with the display name)

Date and time
Displayed in yellow while the time is being corrected.

Display name or group name
For all channel display on the trend display, 
“ALL” is displayed.

Data type
DISP: Display data
EVENT: Event data

Memory sampling progress
Displays the progress using a green bar graph.  The frame indicates the file save 
interval (display data) or the data length (event data).

Displays the remaining memory sampling time for the left bar graph.

When using the login function

When using the batch function

Alarm icon

Status icon

Computation icon (/M1 or /PM1 option)

Date and time

Name of the user logged in
When using the login and batch functions

Date and time

Date and time
Display name

(Red)

(Green)

CF card is being accessed.

Waiting.
Light blue icon: CF card in the slot is not 
recognized. Remove and reset it. 

CF card error.
Carry out the procedure below to reset the CF card icon to 
normal.
• Remove the CF card, and then reinsert it.
• Replace the CF card with a normal one.
• Format the CF card on the DX (the data on the CF card 
  will be erased).

User Locked Icon (/AS1 option)
Displayed when the user is locked.

Displayed when any alarm is activated.
Blinks when there are alarms that are 
occurring but have not been acknowledged.

All alarms have been released after they 
have occurred, but there are alarms that 
have not been acknowledged.

Basic Operation
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Run Modes

Power ON

Basic setting mode

MENU key 
or ESC key

DISP/ENTER 
key

DISP/ENTER 
key ESC key

Setting menu 
display

Basic setting 
menu display

Setup display

Operation display

Setup display

Setting modeOperation mode

MENU key

MENU key 
or ESC key

Mode Transition Diagram

End menu > DISP/ENTER or
ESC > DISP/ENTER
(release number 3 or later)

Hold down FUNC
for 3 s or
Basic Setting Mode
> DISP/ENTER
(release number 3
or later)

On a DX with advanced security 
(/AS1 option; release number 4 or later):
MENU key or ESC key > DISP/ENTER
or
End menu > DISP/ENTER

The DX has three modes.
Mode Description
Operation mode A mode for performing measurements.
Setting mode A mode in which input range, measurement method, and so on 

are configured. Settings can be changed when memory sampling 
is in progress excluding some items.

Basic setting mode A mode used to set basic items such as the scan interval and 
storage format of measured data. On a DX with advanced 
security (/AS1 option; release number 4 or later), the login 
settings can be changed during memory sampling.

* For further details on the basic setting mode and setting mode, see page 67.

Carry out the steps given in the following pages. It will help you to understand the DX 
operation.

Entering Values and Characters
The character/number input keys and DISP/ENTER key are used to set the date/time, 
set the display span of the input range, set the tag, set the message string, enter the 
password, etc.

		

DISP/ENTER key and four arrow
 keys (up, down, left, and right)Character/Number input keys

Basic Operation
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Entering Values
When a window for entering a value appears, enter the value by performing the following 
key operation.
•	 Left and right arrow keys:	 Selects the input position.
•	 Character/Number input keys:	 Enters a value.
The following soft key appears when it can be used.

		

•	 Space soft key:	 Enters a space.

Entering Character Strings
When a window for entering a character string appears, enter it by performing the 
following key operation.
•	 Left and right arrow keys:	 Selects the input position.
•	 Character/Number input keys:	 Enters a character string.
The character to be entered is determined by the number of times the A/a/1 soft key and 
the character/number input key is pressed. The character types that can be entered vary 
depending on the item being set.

Input status of the A/a/1 soft key

Input status of the Ins soft key

•	 Space soft key:	 Enters a space.
•	 Del soft key:	 Deletes the character at the cursor.
•	 Bs soft key:	 Deletes the character before the cursor.
•	 Ins soft key:	 Selects insert or overwrite.
		  Insert and overwrite mode toggles each time the Ins soft key is 

pressed. The selected mode is shown on the right side of the soft 
key display section.

•	 A/a/1 soft key:	 Selects uppercase alphabet (A), lowercase alphabet (a), or value (1).
		  The character type that you can enter changes each time you press 

the A/a/1 soft key. The selected character type is shown on the right 
side of the soft key display section.

Basic Operation
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The contents of the screens in the operation examples below may change depending on 
which options are installed and how the settings are configured.
On a DX with advanced security (/AS1 option; release number 4 or later) you must first 
insert the CF card into the slot (see page 24).

Changing the Date/Time
In this example, we will change the date to the 14th. After carrying out this step, reset the 
time to the correct date/time.

1.	 Display the operation mode screen.

					   

2.	 Press MENU once to display the setting menu.

3.	 Press the down arrow key once. The cursor moves to Date/Time.

4.	 Press the right arrow key once.

					   

Select Time settings.

5.	 Press DISP/ENTER once to open the Time set window.

Basic Operation
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6.	 Set the date to 14.
	 Select the input position:	 Left and right arrow keys 
	 Change the value:	 Character/Number input keys
	 Enter the input:	 DISP/ENTER
	 Cancel the setting:	 Press ESC before pressing DISP/ENTER.

					   

Display the Time set 
window.

7.	 Press ESC twice or MENU once to return to the operation mode screen.
	 On a DX with advanced security (/AS1 option; release number 4 or later):

	 Press ESC twice or MENU once to display a confirmation screen. To return to the 
operation mode screen, select Yes, and press DISP/ENTER once.

Operation complete.

Operation Example in the Setting Mode: Changing the Input Range
Set the input range of channel 2 to thermocouple type T and 0.0 to 400.0°C.

		
Type T 
thermocouple Channel 2

DX2000

1.	 Display the operation mode screen.

					   

2.	 Press MENU once to display the setting menu.

Basic Operation
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3.	 Press the down arrow key twice to select Meas channel.
4.	 Press the right arrow key once.

					   

Select Range, Alarm.

5.	 Press DISP/ENTER once.

					   

Select First-CH.

6.	 Press the +1 soft key once to set First-CH and Last-CH to 2.

7.	 Press the down arrow key once to move the cursor to Mode.

8.	 Press the TC soft key once. The cursor moves to Range, and the changed items 
are displayed in yellow.

					   

Select TC.

9.	 Press the Next soft key.
10.	Press the T soft key once. The cursor moves to Span Lower.

Basic Operation



21IM 04L42B01-02E

11.	 Press the Input soft key once.

					   
Display the span lower 
setting window. 	

12.	Enter 0.0 in the Span Lower box.
	 Select the digit:	 Left and right arrow keys
	 Change the value:	 Character/Number input keys
	 Delete the value:	 Space soft key
	 Cancel the setting:	 Press ESC before pressing DISP/ENTER.

13.	Press DISP/ENTER once. The cursor moves to Span Upper.

14.	Enter 400.0 in the Span Upper box.
	 See step 12 for the procedure.

15.	Press DISP/ENTER once. The changed items are entered, and the cursor returns 
to First-CH. The changed items change from yellow to white.

					   

16.	Press ESC three times or MENU twice to return to the operation mode screen.
	 On a DX with advanced security (/AS1 option; release number 4 or later):

	 Press ESC three times or MENU twice to display a confirmation screen. To return 
to the operation mode screen, select Yes, and press DISP/ENTER once.

Operation complete.

Basic Operation
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Operation Example in the Basic Setting Mode: Changing the Scan Interval
In this example, we will change the scan interval. Here, the scan interval on the DX2010 
is changed to 2 s. The selectable scan intervals are different on the DX2004 and 
DX2008, but the procedure is the same.

		
Type T 
thermocouple Channel 2

Measures every 2 s
DX2000

1.	 Display the operation mode screen.

					   

2.	 Press MENU once to display the setting menu.

					   

3.	 Hold down FUNC for at least 3 s.

					   

Display the basic setting 
mode menu
Alternatively, you can 
execute the following 
procedure to switch to 
Basic Setting mode.
Use the up or down arrow 
key to select Basic setting 
mode on the Menu tab, 
and press DISP/ENTER.
A confirmation window will 
appear. Select Yes, and 
press DISP/ENTER.

4.	 Press the down arrow key twice to select A/D, Memory.

Basic Operation



23IM 04L42B01-02E

5.	 Press DISP/ENTER once.

					   

6.	 Press the down arrow key once to move the cursor to Scan interval.
7.	 Press the 2s soft key once. The cursor moves to A/D integrate, and the changed 

item is displayed in yellow.
	 Cancel the setting: Press ESC before pressing DISP/ENTER.
8.	 Press DISP/ENTER once. The changed items are entered, and the cursor returns 

to Scan mode.

					   

Set the scan interval to 2 s.

9.	 Press ESC once to return to the basic setting mode menu.
10.	Press ESC once more.

	Alternatively, use the up or down arrow key to select End, and press DISP/ENTER.

					     Display the confirmation 
window.

11.	 Press DISP/ENTER once. The settings are saved, and the DX returns to the 
operation mode screen.

	 Discard the changes:	 Select No and press DISP/ENTER.
	 Do not end the basic setting mode:	 Select Cancel and press DISP/ENTER.
Operation complete.

Basic Operation
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Inserting/Removing a CF Card
Inserting a CF Card

1.	 Open the operation cover.

					   

CF card With the label “This side up” 
facing up

This side up

CAUTION

Forcing the CF card into the slot with 
the upside down may cause damage.

2.	 Insert the CF card into the slot.

					   

Displays the storage 
media icon.

3.	 Close the operation cover.

Operation complete.

Removing a CF Card
<Operations in the Operation Mode>

1.	 Press FUNC once.

2.	 Press the Media eject soft key once.

					   

Storage media icon

Media eject

Basic Operation
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3.	 Press the CF soft key once. The message “Media can be removed safely” 
appears.

4.	 Open the operation cover.

5.	 Press the CF card eject button. When you eject the CF card, the CF card icon 
disappears.

					   

Eject button

Press the eject button in until it clicks.  
The eject button stops at depressed 
position.  Pinch the left and right side 
of the CF card and remove it.

6.	 Close the operation cover.

Operation complete.

<Operation in the Basic Setting Mode>
1.	 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to 

basic setting mode), select the File/Initialize tab > Media eject > CF *, and press 
DISP/ENTER.
* Select CF if you have a choice between CF and USB.

					   

	 The message “Media can be removed safely” appears.

2.	 Open the operation cover.

3.	 Press the CF card eject button. Remove the CF card.

4.	 Close the operation cover.

Operation complete.

Note
If you remove the CF card without carrying out the media eject procedure, the message “Media 
was removed compulsorily” appears. Remove the CF card by carrying out the procedure above 
to prevent damaging the data that is stored.

Basic Operation



26 IM 04L42B01-02E

Saving the Setup Data
In this example, we will save the setup data to a file named “SF2” on the CF card.

1.	 Display the operation mode screen.

					   

2.	 Press MENU once to display the setting menu.

3.	 Press the right arrow key once to select the File tab.

4.	 Press the down arrow key four times.

					   

Select Save settings.

5.	 Press DISP/ENTER once.
6.	 Enter “SF2” for the file name.
	 For the input procedure, see “Entering Values and Characters” on page 16.

					   

7.	 Press DISP/ENTER once. The message “Data are being saved to media” 
appears, and the setup data is saved.

8.	 Press ESC or MENU twice to return to the operation mode screen.
	 On a DX with advanced security (/AS1 option; release number 4 or later):

Basic Operation
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	 Press ESC or MENU twice to display a confirmation screen. To return to the 
operation mode screen, select Yes, and press DISP/ENTER once.

Operation complete.

Loading the Setup Data
In this example, we will load the setup data “SF2” from the CF card and update the DX 
settings.
This procedure only loads the setup data that the DX uses for setting mode.To load the 
setup data for both setting mode and basic setting mode, press MENU, hold down FUNC 
for 3 s, select the File/Initialize tab > Load settings, and press DISP/ENTER.

1.	 Display the operation mode screen.

2.	 Press MENU once to display the setting menu.

3.	 Press the right arrow key once to select the File tab.

4.	 Press the down arrow key three times.

					   

Select Load settings

5.	 Press DISP/ENTER once to select the root directory (CF:/).

6.	 Press DISP/ENTER once to display the files in the root directory.

7.	 Select the file SF2 using the up and down arrow keys.

					   

To move to a lower  
directory, select the 
directory, and press 
DISP/ENTER.

To move to a higher 
directory, press ESC.

8.	 Press DISP/ENTER once. The message “File is being loaded from media” 
appears, and the setup data is loaded. The DX automatically returns to the 
operation mode screen.

Operation complete.

Basic Operation
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Setting the Input Range and Alarm

Setup Example 1: Temperature Measurement Channel

			 
Type T 
thermocouple Channel 1

0.0 to 200.0°C

DX2000

Setup Item Description Number in the Figure
Channel Use channel 1. 1
Tag TI-001 2
Sensor Type T thermocouple 3
Input range 0.0 to 200.0°C 4

(1) Input Range
	 Press MENU (to switch to setting mode). 
	 Select the Menu tab > Meas channel > Range, Alarm.

			 

1

4

3

(2) Tag
	 Select the Menu tab > Meas Channel > Tag, Memory sample, Alarm delay.

			 

2

Operation complete.
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Setup Example 2: Flow Rate Measurement Channel and Alarm

			 

DX2000

Flowmeter Channel 2

4 - 20 mA

Convert to 1-5 V with a shunt resistor

Setup Item Description Number in the Figure
Channel Use channel 2. 1
Tag FI-002 2
Input signal 1-5V 3
Input range 0.0 to 500.0 L/H 4
Alarm condition Output an alarm if the measured value is 

less than or equal to 120.0 L/H.
Output destination: Relay contact (I03)

5

(1) Input Range and Alarm
	 Press MENU (to switch to setting mode). 
	 Select the Menu tab > Meas Channel > Range, Alarm.

			 

1

5

4

3

(2) Tag
	 Select the Menu tab > Meas Channel > Tag, Memory sample, Alarm delay.

			 

2

Operation complete.

Setting the Input Range and Alarm
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Setting the Display

Setup Example 3: Assigning Channels to Groups
In this example, we will assign channels 1 and 2 to group 1.

			 

Channel 1

Group 1

Channel 2

Setup Item Description Number in the Figure
Group Assign channel 1 and 2 to group 1. 1

(1) Group
	 Press MENU (to switch to setting mode), and select the Menu tab > Group set, Trip 

line.

			 

1

Operation complete.
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Setup Example 4: Setting the Time Scale
Set the time per division of the trend waveform to 2 minutes.

			 

The sampling interval (the time 
corresponding to 1 dot) is 4 s 
when the trend interval is 2 min.
30 dots × 4 s = 2 min

30 dots/div

Setup Item Description Number in the Figure
Trend interval Set the time per division to 2 minutes.

The waveform is updated at every 4 s.
1

(1) Trend Interval
	 Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend/

Save interval.

			 

1

Operation complete.

Setting the Display
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Setting the Data Storage

Setup Example 5: Continuously Record Measured Data and Automatically Save
In this example, we will continuously record and save the measured data of channel 1 
and 2.
For the procedure to set the channel, see “Setting the Input Range and Alarm” on page 
28.
For the procedure to set groups, see “Setting the Display” on page 30.

			 

Channel 1

Automatically save to 
the CF card periodically.

Channel 2

Setup Item Description Number in the Figure
Source channels Channel 1 (TI-001) and channel 2 (FI-002) 1
Data to be recorded Continuously record the display data from the start of the 

measurement.
2

Data storage method Automatically store every 24 hours. 3
Sampling interval 4 seconds. Set using the trend interval.

Sampling interval = (trend interval setting)/30 dots*

* 40 dots when the trend interval is set to 5 or 10 seconds.

4

Data file name Add “sample” to the file name. 5
Example: 000123_sampleYYMMDD_HHMMSS.DAD

↑	 ↑
Sequential number  Date/Time of the first recorded data

Save Destination  
Directory

DATA-101 6

(1) Data to be Recorded
	 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode).
	 Select the Menu tab > A/D, Memory.

			   2
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(2) Method of Storing to the CF Card (Auto Save ON/OFF)
	 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode).
	 Select the Environment tab > Security, Media save, Batch.

			   3

(3) Save the Settings
1.	 Press ESC to return to the basic setting menu.
2.	 Press ESC once more.

	The window appears for you to confirm the saving of the settings.

3.	 Select Yes and press DISP/ENTER.
	 The DX returns to the operation mode screen.

(4) Channels to Be Recorded
	 Press MENU (to switch to setting mode). 
	 Select the Menu tab > Meas Channel > Tag, Memory sample, Alarm delay.

			 

1

Setting the Data Storage
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Setting the Data Storage

(5) Interval for Saving the Data to the CF Card
	 Select the Menu tab > Display > Trend/Save interval.

			 

4
3

(6) Data File Name
	 Select the Menu tab > Data save > File header, Data file name.

			   5

(7) Save Destination Directory (within the CF Card)
	 Select the Menu tab > Data save > Save directory.

			 

6

Operation complete.
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Setup Example 6: Saving Measured Data at the Specified Time
Using the settings of Setup Example 5, we will save the measured data once at hour 0 
every day.

			 

Every hour 0
DX2000 Automatically save 

to the CF card
7 56

1211
10

8 4

2
1

9 3

All settings other than those listed below are the same as Setup Example 5.
Setup Item Description Number in the Figure
Data storage time Save the data once at hour 0 every day. 7
Data storage method Automatically save the measured data at 

the specified time.
8

(1) Setting the Time
	 Press MENU (to switch to setting mode). 
	 Select the Menu tab > Timer, Event action > Match time timer.

			 

7

(2) Specifying the Data Storage
	 Press MENU (to switch to setting mode). 
	 Select the Menu tab > Timer, Event action > Event action.

			 

8

Operation complete.

Setting the Data Storage
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Customizing the Operation

Setup Example 7: Assigning the Screen Image Data Storage Function to the 
USER key

In this example, we will set the DX so that the displayed screen image data can be saved 
to the CF card by pressing the USER key. This function is called snapshot. The extension 
of snapshot data files is .png.

			 

USER key

Setup Item Description Number in the Figure
Event action Save the screen image data of the DX 

using the USER key. 
1 

(1) Assigning an Action to the USER Key
	 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Event action.

			 

1

Operation complete.
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Setup Example 8: Registering Frequently Used Screens to the Favorite Key
Up to eight operation mode screens that are frequently used can be registered to the 
Favorite key. This enables you to monitor the operation by using only the Favorite key. 
This feature is convenient when comparing data such as historical trends.

		

Favorite key

Favorite key

Favorite key
Example when three screens are
registered to the Favorite key

Favorite key

Favorite key

1.	 Display the screen to be registered.

					   

2.	 Press FUNC once to display the FUNC key menu.

3.	 Press the Next soft key to display Favorite regist.

4.	 Press the Favorite regist soft key to display the registration list window.

					   

Show the registration list 
window.

Customizing the Operation
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Customizing the Operation

5.	 Press the favorite number (1 to 8) soft key.

6.	 Press the Regist soft key.

					   
Show the window for 
entering the display name.

7.	 Enter the screen name.
	 Select the digit:	 Left and right arrow keys
	 Enter characters:	 Character/Number input keys
	 Delete a character:	 Del soft key or Bs soft key
	 Cancel the setting:	 Press ESC before pressing DISP/ENTER.

	 For the input procedure, see “Entering Values and Characters” on page 16.

8.	 Press DISP/ENTER once.

9.	 Repeat steps 1 to 8 to register up to eight screens.

Operation complete.
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Operation

Starting Memory Sampling
1.	 Press START once.
	 On a DX with advanced security (/AS1 option; release number 4 or later) display 

the start recording screen*. With START selected, press DISP/ENTER once.
	Memory sampling starts.
*	 This is because the Batch function is enabled upon shipment from the factory.

					   

START key

Memory sampling progress
DISP: Display data
EVENT: Event data

Recording data

Operation complete.

Stopping Memory Sampling
1.	 Press STOP once.

					     Display the confirmation 
window.

2.	 Select Mem+Math or Memory using the left and right arrow keys.
	 Memory:	 Stops memory sampling.

	 Mem+Math:	 Stops memory sampling and computation (option).

	 On models without the computation function (option), the confirmation message 
“Do you want to stop data storage?” appears. Select Yes.

3.	 Press DISP/ENTER once.

					   
Stop memory sampling.

Operation complete.



40 IM 04L42B01-02E

Operation

Switching the Trend Display, Digital Display, and Bar Graph Display
1.	 Press DISP/ENTER once to show the display selection menu.

					   

DISP/ENTER key

Down arrow key

Right arrow key

Left arrow key

Up arrow key

2.	 Press the down arrow key to select TREND, DIGITAL, or BAR.
3.	 Press the right arrow key once to display the sub menu. To close the sub menu 

that you opened, press the left arrow key.
4.	 Press the down arrow key to select the group.

					     Select DIGITAL > GROUP 1.

5.	 Press DISP/ENTER once to show the operation display of the selected group. To 
close the menu without switching the display, press ESC.

					   
Digital display

Group number

Operation complete.

Press the down arrow key when the trend, digital, or bar graph is displayed to switch the 
display in the order trend, digital, bar graph, trend, and so on. Press the up arrow key 
to switch the display in reverse order. Press the right arrow key or the left arrow key to 
switch the group.
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Writing the Message “START”
Registering the Word “START” in Message Number 1

On a DX with advanced security (/AS1 option; release number 4 or later), this operation 
is only available when memory sampling is stopped.

1.	 Press MENU (to switch to setting mode), and select the Menu tab > Message, 
Comment > Message > DISP/ENTER.

2.	 Press 1-10 soft key.
	 The message, “Message numbers 1-10 can also be used for free message” appears. Press 

DISP/ENTER.

3.	 Press the down arrow key. With message 1 selected, press the Input soft key.
Enter “START”.

					     Show the message 
registration window.

	 Select the digit:	 Left and right arrow keys
	 Enter characters:	 Character/Number input keys
	 Delete a character:	 Del soft key or Bs soft key
	 Cancel the setting:	 Press ESC before pressing DISP/ENTER.

	 For the input procedure, see “Entering Values and Characters” on page 16.

4.	 Press DISP/ENTER.

					   

5.	 Press ESC three times or MENU twice to return to the operation mode screen.
	 On a DX with advanced security (/AS1 option; release number 4 or later):

	 Press ESC three times or MENU twice to display a confirmation screen. To return 
to the operation mode screen, select Yes, and press DISP/ENTER.

Operation complete.

Operation
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Writing Message Number 1 “START”
This operation can be carried out while memory sampling is in progress. The message is 
displayed on the trend display. Show the trend display first.

1.	 Press FUNC (display the FUNC key menu), press the Message soft key, and 
press the 1 - 10 soft key.

					   
Show the message 
registration window.

1 soft key

2.	 Press the 1 soft key.

					   

Shows the message 
(time, message, and 
message mark).
Also recorded to the 
internal memory.

Operation complete.

Operation
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Connecting to an Ethernet Network

Setup Example 9: Monitoring the DX on a PC Browser
In this example, we will connect the PC and the DX via hub in a one-to-one relationship 
and display and monitor the DX screen on a browser on the PC.

			 
DX2000

PC

Ethernet
HUB

	 DX
Setup Item Description Number in the Figure
IP address 192.168.1.101 1
Subnet mask 255.255.255.0
Web server function Monitor from a Web browser on the PC 

using operator page.
2 

Access to the DX Display the Web page and do not set 
access privileges.

3

	 PC
Setup Item Description Number in the Figure
IP address 192.168.1.100 4
Subnet mask 255.255.255.0

(1) IP Address of the DX
	 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode).
	 Select the Menu tab > Communication (Ethernet) > IP address, Host settings.

			   1
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(2) Enabling the Web Server Function on the DX
	 Select the Menu tab > Communication (Ethernet) > Server > Server.

			 

2

(3) Display the DX Screen on the PC
	 Select the Menu tab > Communication (Ethernet) > Web page.

			 

2

3

(4) Save the Settings
1.	 Press ESC twice to return to the basic setting menu.

2.	 Press ESC once more.
	The window appears for you to confirm the saving of the settings.

3.	 Select Yes and press DISP/ENTER.
	 The DX returns to the operation mode screen.

Connecting to an Ethernet Network
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(5) Setting the PC
	 Set the IP address and subnet mask on the PC.

			 

4

(6) Checking the Connection
	 Send the command below from the PC and check that a correct response is returned.
	 Send
	 >ping 192.168.1.101

	 Response example
	 >Reply from 192.168.1.101: bytes=32 time<10ms TTL=255

(7) Displaying the DX Screen on the Browser
1.	 Start the browser on the PC.

2.	 Enter the following URL.
	 http://192.168.1.101/operator.htm

3.	 Check that the DX screen appears.

					   

Operation complete.

Connecting to an Ethernet Network
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Connecting to an Ethernet Network

Setup Example 10: Automatically Transferring the Measured Data File to an FTP 
Server

In this example, we will configure the DX so that the measured data is automatically 
transferred to an FTP server on the network when the measured data is automatically 
saved to the CF card.
This example assumes that the following network environment is used: DHCP enabled, 
automatically obtain the DNS server information, and automatically register the DX host 
name to the DNS server. Set the parameters according to your network environment.

		

DX

Measurement input

Ethernet
Automatic data transfer to an FTP server

CF card

FTP server

Internal
memory

Setup Item Description Number in the Figure
Host name DAQSTATION1 1
Obtain the IP address Obtain automatically (DHCP) 2
Type of data to be transferred Acquired measured data 3
FTP server Server name abcdefg.co.jp 4

Port number 21
Login name FTPUSER1
Password a1234

(1) Host Settings and IP Address of the DX
	 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode). and select the Menu tab > Communication (Ethernet) > IP address, 
Host settings.

			 

1

2
Automatically obtain the 
DNS server information. 
Automatically register the 
DX host name to the DNS 
server.

(2) Data to Be Transferred to the FTP Server
	 Select the Menu tab > Communication (Ethernet) > FTP client > FTP transfer file.

3



47IM 04L42B01-02E

(3) Connected setting FTP Server
	 Select the Menu tab > Communication (Ethernet) > FTP client > FTP connection.

			 

4

(4) Save the Settings
1.	 Press ESC three times to return to the basic setting menu.

2.	 Press ESC once more.
	The window appears for you to confirm the saving of the settings.

3.	 Select Yes and press DISP/ENTER.
	The DX returns to the operation mode screen.

Operation complete.

Executing a File Transfer Test
1.	 Press FUNC once to display the FUNC key menu.

2.	 Press the Next soft key until FTP test is displayed, and then press the FTP test 
soft key.

					   

FTP test soft key

3.	 Press the Primary soft key once. The messages “FTP test is being executed” and 
“Execution is complete” are displayed. The test file (FTP_TEST.TXT) is sent to the 
FTP server.

Operation complete.

Transferring the Data Files
When you start memory sampling, the measured data file is transferred to the FTP server 
when the data is saved to the CF card.

Connecting to an Ethernet Network
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Using DAQSTANDARD

Displaying the Measured Data on DAQSTANDARD
In this example, we will display the measured data using the software program, 
DAQSTANDARD.

1.	 Insert the CF card containing the measured data file into the PC that has 
DAQSTANDARD installed.

2.	 Start DAQSTANDARD Viewer.

					   

3.	 From the File menu, choose Open.
4.	 In the Open dialog box, select the desired file, and click Open.
	 The data is displayed.

					   

Operation complete.



49IM 04L42B01-02E

Installation and W
iring

R
ecom

m
ended R

eplacem
ent 

Periods for W
orn Parts

Setup Item
s and 

D
efault Values

Installation and Wiring

Installation Location
Install the DX indoors in a location that meets the following conditions.
•	 Instrumentation Panel
	 The DX is designed to be installed in an instrumentation panel except for the desktop 

type.
•	 Well-Ventilated Location
	 To prevent overheating, install the DX in a well-ventilated location. For the panel cut 

dimensions when arranging multiple DXs, see the page 51. Follow the panel cut 
dimensions providing adequate space between instruments when other instruments 
are arranged on the panel. For the desktop type, we recommend that a space of at 
least 50 mm be provided around the left, right, and top panels of the DX.

•	 Minimum Mechanical Vibrations
	 Choose an installation location with the minimum mechanical vibration. Installing the 

DX in a location with large mechanical vibration not only causes adverse effects on 
the mechanism but also may hinder normal recording.

•	 Horizontal
	 Install the DX horizontally (However, the DX can be inclined up to 30 degrees 

backwards for panel mounting).
•	 Ambient temperature range between 0 to 50°C
•	� Ambient humidity between 20 to 80%RH ( However, less than moisture 

content of 40°C 80% RH at 40°C or more), No condensation should be 
present.

• Altitude 2000 m or less

Note
Condensation may occur if the DX is moved to another place where the ambient temperature is 
higher, or if the temperature changes rapidly. In addition, measurement errors will result when 
using thermocouples. If this happens, let the DX adjust to the new environment for at least one 
hour before using it.

Do not install the DX in the following places.
•	 Outdoors
•	 In Direct Sunlight or Near Heat Sources
	 Install the DX in a place with small temperature fluctuations near room temperature 

(23°C). Placing the DX in direct sunlight or near heat appliances can cause adverse 
effects on the internal circuitry.

•	 Where an Excessive Amount of Soot, Steam, Moisture, Dust, or 
Corrosive Gases Are Present

	 Soot, steam, moisture, dust, and corrosive gases will adversely affect the DX. Avoid 
such locations.

•	 Near Strong Magnetic Field Sources
	 Do not bring magnets or instruments that produce electromagnetic fields close to the 

DX. Operating the DX in strong magnetic fields can cause errors in the measurements.
•	 Where the Viewing of the Display Is Poor
	 The DX uses a TFT color LCD for the display. Therefore, viewing of the display from 

an extreme angle is difficult. Install the DX so that the user can view the display from 
the front.
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Installation Procedure
Installation Procedure (Panel Mount Type)

Use a steel panel of thickness 2 mm to 26 mm.
1.	 Insert DX from the front of the panel.
2.	 Mount the DX to the panel using the mounting brackets that come with the 

package as shown in the figure below.
•	 Use two brackets to support the top and bottom or the left and right sides of 

the case (remove the seal that is covering the holes for the mounting brackets 
beforehand).

•	 The proper torque for tightening the mounting screws is 0.7 to 0.9 N•m.
•	 Mount the DX to the rack according to the procedure below.

•  First, attach the two mounting brackets and temporarily fasten the 
attachment screws.

•  Next, fix the DX in place by tightening the attachment screws with the 
appropriate torque. When the DX is approximately perpendicular to the 
panel as you fasten the screws, press the mounting bracket against the 
case so that they are in contact with each other.

	 CAUTION
•	 Tightening the screws too much can deform the case or damage the bracket.
•	� Be careful not to insert foreign objects or tools through the holes for the 		

mounting brackets in the case.
•	� Make sure the rubber gasket is affixed so that it does not become entangled 

between the main unit and the panel. Affixing the gasket incorrectly will result in 
failure to achieve sufficient dust and water proof performance.

				  
Bezel

Correct

Panel

Rubber gasket

Incorrect: Gasket entangled

Panel

Rubber gasket
Bezel

Panel Mounting Diagram

		

Screw temporarily Fixed

Front

Panel

Panel

Mounting 
brackets

Mounting brackets

Torque driver
(flat blade)

Attachment screw
DX case

In contact with 
each other

(The figure shows the case when the mounting brackets 
are used on the top and bottom of the case.)

Attachment 
screw

Note
To achieve sufficient dust and water proof performance, mount the DX in the middle of the 
panel cut out.

Installation and Wiring
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External Dimensions and Panel Cut Dimensions
Panel Mount Type

(14.17)

(11.06)

(1
4.

21
)

(1
1.

06
)

Unit: mm (approx. inch)
Unless otherwise specified, tolerance 
is ±3% (however, tolerance is ±0.3 mm 
when below 10 mm).

280.2 (11.03)

180 (7.09)

108
 (4.25)

54.6 
(2.15)

32.1

27.3
 (1.07)

2–26
168 (6.61)
221.6 (8.72)

226 (8.90) max.

(Dimensions before attaching 
the mounting bracket)

(When the /H2 or /PM1 
option is installed)

(Allowable panel thickness)

(Dimensions after attaching 
the mounting bracket)

288 (11.33)
295.2 (11.62)

360 min.

36
1 

m
in

.

18
0 

(7
.0

9)

10
8 28

8 
(1

1.
33

)

28
0.

2 
(1

1.
03

)
9.

4 
(0

.3
7)

7.
5

 (0
.2

9)

29
5.

2 
(1

1.
62

)

Panel cut dimensions

 281+2
  0

 2
81

+2   0

Desktop Type (/H5[ ] Option)

		  289.6 (11.40) 245.1 (9.65)

282.5 (11.12)

253.3 (9.97) max.

25
 (0

.9
8)

28
9.

7 
(1

1.
41

)

28
7.

8 
(1

1.
33

)
40

 (1
.5

7)

35
2.

8 
(1

3.
89

)

(When the /H2 or /PM1 
option is installed)

Unit: mm (approx. inch)
Unless otherwise specified, tolerance 
is ±3% (however, tolerance is ±0.3 mm 
when below 10 mm).
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Input Signal Wiring

	 WARNING
•	 To prevent electric shock while wiring, ensure that the power supply source is 

turned OFF.

CAUTION
•	 If a strong tension is applied to the cable wired to the DX, the terminals of the DX 

and/or the cable can be damaged. In order to prevent tension from being applied 
directly on the terminals, fasten all wiring cables to the rear of the mounting panel.

•	 To prevent fire, use signal wires having a temperature rating of 70°C or more.
•	 Do not apply a voltage exceeding the following value to the input terminals. 

Otherwise, damage to the DX may result.
	 •	 Maximum input voltage: ±60 VDC
	 •	� Maximum common mode voltage: ±60 VDC (under measurement category II 	

conditions)

Precautions to Be Taken While Wiring
Take the following precautions when wring the input signal cables.
When using a screw terminal, we recommend that you use a crimp-on lug 
with an insulation sleeve (designed for 4-mm screws).

			   Crimp-on lug with insulation sleeves (for 4 mm screws)
When using a clamp terminal (/H2), we recommend that you use the 
following kind of cable:
•	 Conductive cross-sectional area: 0.08 mm2 to 1.5 mm2 (AWG 28 to 16)
•	 Length of the stripped section of the wire: Approx. 7 mm
Take measures to prevent noise from entering the measurement circuit.
•	 Move the measurement circuit away from the power cable (power circuit) and ground circuit.
•	 It is desirable that the object being measured does not generate noise. However, if 

this is unavoidable, isolate the measurement circuit from the object. Also, ground the 
object being measured.

•	 Shielded wires should be used to minimize noise caused by electrostatic induction. 
Connect the shield to the ground terminal of the DX as necessary (make sure you are 
not grounding at two points).

•	 To minimize noise caused by electromagnetic induction, twist the measurement circuit 
wires at short, equal intervals.

•	 Make sure to earth ground the protective ground terminal through minimum resistance 
(less than 100 Ω).

Do not allow static electricity to be applied to the terminals.
•	 When wiring the terminals, remove static electricity so that static electricity is not applied.
•	 If static electricity or similar high-voltage transient noise is applied to the signal line, 

the system may break.
When using internal reference junction compensation on the thermocouple 
input, take measures to stabilize the temperature at the input terminal.
•	 Always use the terminal cover.
•	 Do not use thick wires which may cause large heat dissipation (cross sectional area of 

0.5 mm2 or less recommended).
•	 Make sure that the ambient temperature remains reasonably stable. Large 

temperature fluctuations can occur if a nearby fan turns ON or OFF.
Connecting the input wires in parallel with other devices can cause signal 
degradation, affecting all connected devices. If you need to make a parallel 
connection, then
•	 Turn the burnout detection function OFF.
•	 Ground the instruments to the same point.
•	 Do not turn ON or OFF another instrument during operation. This can have adverse 

effects on the other instruments.
•	 RTDs cannot be wired in parallel.
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Wiring Procedure
A terminal cover is screwed in place on the measuring input terminal block on the rear 
panel. A label indicating the terminal arrangement is affixed to the cover.

1.	 Turn OFF the DX and remove the terminal cover.

2.	 Connect the signal wires to the terminals.

Recommended torque for 
tightening the screws

Screw terminals 0.9 to 1.0 N•m
Clampted terminals 0.22 to 0.25 N•m

3.	 Replace the terminal cover and fasten it with screws. The proper torque for 
tightening the screws is 0.6 N•m.

Note
Input signal wires of diameter less than or equal to 0.3 mm may not be secured firmly for 
clamped terminals (/H2). Fold over the conducting section of the wire, for example, to make 
sure that the wire is securely connected to the clamped terminal.

Arrangement of the Input Terminals

			 

Input
terminal 
block

1
2
3
4

DX2004 DX2008 DX2010 DX2020 DX2030 DX2040 DX2048
 1–4 1–4 1–10  1–10 1–10  1–10  1–12
  5–8  11–20 11–20 11–20 13–24
     21–30 21–30 25–36
      31–40 37–48

Channel Assignments by Model

Input terminal block 1

Input terminal block 2

Input terminal block 3

Input terminal block 4

+/A
/b

CH1
CH2

CH3
CH4

CH5
CH6

CH7
CH8

CH9
CH10

CH1
CH2

CH3
CH4

CH5
CH6

CH7
CH8

CH9CH11
CH10CH12

–/B

+/A
/b

–/B

CH3 CH1

CH4 CH2

CH5 CH3 CH1

CH6 CH4 CH2

CH9 CH7

CH10

CH11

CH12 CH8

CH5 CH3 CH1

CH6 CH4 CH2

CH9 CH7

CH10 CH8

/b
+/A
–/B

/b
+/A
–/B

/b
+/A
–/B+/A

/b
CH1

CH2
CH3

CH4

–/B

Screw terminal

Input terminal block 1 of 
the DX2004 and DX2008

Input terminal block 1 of 
the DX2010, DX2020, 
DX2030, and DX2040

Input terminal block 1 of 
the DX2048

Clamp terminal

Installation and Wiring
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Wiring Screw Terminals

–

+ +

–
DC voltage input

TC inputDC voltage input/DI (ON/OFF) input

RTD input DC current input

DC current input

Shunt resistor
Example: For 4 to 20 mA input, use a 
 shunt resistor of 250 Ω ± 0.1%.

–

+

–

+

–

+

A

B

b

Lead wire resistance per wire of 
10 Ω or less. Make the resistance 
of the three wires equal.

Compensating leadwire

A

b
B

Wiring Clamped Terminals

CAUTION
As of August, 2007, the direction of the terminal blocks for the clamp input terminals  
(/H2 option) has changed. To use clamp input terminal blocks wired for use with 
previous YOKOGAWA recorders, rewire them to match the DX.

Remove the terminal block
Hold both ends of the terminal 
block and pull straight.

Input signal wire
First, loosen the screw at the front using a flat-blade 
screwdriver.  Insert the input signal wire into the slit on the 
left side of the terminal block, and fasten the screw at the front.

Recommended wire size
0.08 to 1.5 mm2 (AWG 28 to 16)

Recommended 
length of stripped 
wire: 7 mm

Connect the wires

Flat-blade 
screwdriver

Connect the terminal block
Hold both ends of the terminal block, 
align with the connector on the DX 
side, and push the terminal block into 
the connector.

Note
RTD input terminals A and B are isolated on each channel. Terminal b is shorted internally 
across all channels. However, terminal b is also isolated on each channel on models with the  
/N1 option (Cu10, Cu25 RTD input/3 leg isolated RTD) and /N2 option (3 leg isolated RTD).
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Optional Terminal Wiring

	 WARNING
•	 To prevent electric shock while wiring, ensure that the power supply source is 

turned OFF.
•	 If a voltage of more than 30 VAC or 60 VDC is to be applied to the output terminals, 

use ring-tongue crimp-on lugs with insulation sleeves on all terminals to prevent the 
wires from slipping out when the screws become loose. Furthermore, use double-
insulated wires (dielectric strength of 3000 VAC or more) for the signal wires on which 
a voltage of more than 30 VAC or 60 VDC is to be applied. For all other wires, use 
basic insulated wires (dielectric strength of 1500 VAC). To prevent electric shock, 
attach the terminal cover after wiring and make sure not to touch the terminals.

CAUTION
•	 Use the following circuit voltage for the connection to the alarm/FAIL/status 

output terminal.
•	 When the connection is to Mains Circuits (primary AC power source circuits):
			   150 V or less
•	 When the connection is to circuits derived from Mains Circuits (secondary 

circuits):	 250 V or less
	 (Mains Circuits voltage is less than 300 V, and connection must be used by 

isolation transformer.)
•	 To prevent fire, use signal wires having a temperature rating of 70°C or more.
•	 If a strong tension is applied to the cable wired to the DX, the terminals of the DX 

and/or the cable can be damaged. In order to prevent tension from being applied 
directly on the terminals, fasten all wiring cables to the rear of the mounting panel.

•	 Do not short the transmitter power supply output terminal or apply external 
voltage to it. If you do, the DX may malfunction.

•	 When using the transmitter power supply output terminal, do not use current that 
exceeds the maximum output current (25 mADC). If you do, the DX may malfunction.

•	 Do not short the VIDEO OUT terminal or apply external voltage to it. If you do, 
the DX may malfunction.

Note
For remote control wiring, use shielded wires to reduce noise. Connect the shield to the 
functional ground terminal or the ground terminal of the DX.

Precautions to Be Taken While Wiring
It is recommended that crimp-on lug with insulation sleeves (designed 
for 4-mm screws) be used when connecting wires to the optional input 
terminals.

			   Crimp-on lug with insulation sleeves (for 4-mm screws)

Wiring Procedure
As shown in the figure on next page, the optional terminal block is located on the rear panel. The 
optional terminal block is provided on the DX when an option that requires input/output is installed 
such as the alarm output relay (/A[ ] option), FAIL/status output relay (/F1 or /F2 option), and 
remote control function (/R1 option), etc. A terminal cover is screwed in place on the measuring 
input terminal block. A label indicating the terminal arrangement is affixed to the cover.

1.	 Turn OFF the DX and remove the terminal cover.
2.	 Connect the signal wires to the terminals. The recommended torque for tightening 

the screws is 0.9 to 1.0 N•m
3.	 Replace the terminal cover and fasten it with screws. The proper torque for 

tightening the screws is 0.6 N•m.

Installation and Wiring
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Arrangement of the Optional Terminals

		

Optional terminal block 1

Optional terminal block 2

Optional terminal block 3

Optional terminal block 4

Description of Symbols

1 to 8: Terminal number
C: Common
See page 61.

NC: Normally closed
C: Common
NO: Normally opened
See page 61.

NC
Remote control inputAlarm output, FAIL, Status

H and L: See page 61.
Pulse input

+ and –: See page 61.
Transmitter power supply

Symbols such as “NC”: Terminal functions

A terminal that is not used. (With a screw)

A terminal that is not used. (Without screw)

1

Options That Use Option Terminal Block 1 Only

(To next page)

These options can come with /TPS4 or /TPS8.
In that case, the option terminal block 4, or option terminal blocks 3 and 4 are installed.
For the terminal arrangement for /TPS4 and /TPS8, see page 57.

02 0104 03

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO
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C

NO
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C
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C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C
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NC

C

NO

NC

C

NO
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C

NO

NC

C
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NC

C
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C
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C

NO

NC

C

NO
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C

NO

NC

C
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NC

C
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C

NO
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C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

02 01

02 0104 0306 05

C

1

28

7

6

5

4

3 C

1

28

7

6

5

4

3C

1

28

7

6

5

4

3

02 0104 0306 05

02 01

C

1

28

7

6

5

4

3

NC

C

NO

NC

C

NO

02 01

02 0104 03

02 0104 03

02 0104 0306 05

/A1 /A2 /A3

/A1/R1 /A2/R1 /A3/R1

/R1 /A1 /F1 /A2 /F1

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Remote
control
input

Remote
control
input

Remote
control
input

Remote
control
input

FAIL
Status 

FAIL
Status 



57IM 04L42B01-02E

Installation and W
iring

R
ecom

m
ended R

eplacem
ent 

Periods for W
orn Parts

Setup Item
s and 

D
efault Values

(From previous page)

02 01

C

1

28

7

6

5

4

3 NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

C

1

28

7

6

5

4

3

02 0104 03

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

02 01

/F1 /A1 /F1 /R1 /A2 /F1 /R1
Alarm 
output

Alarm 
output

Remote
control
input

Remote
control
inputFAIL

Status 
FAIL

Status 
FAIL

Status 

NC

C

NO

NC

C

NO

Pulse 
input

Pulse 
input

02 0104 03

NC

C

NO

NC

C

NO

02 01

CH

L

H

L

H

L 1

25

4

3

Alarm 
output

Alarm 
output

Alarm 
output

NC

C

NO

NC

C

NO

02 7 68

02 01

CH

L

H

L

H

L 1

25

4

3NC

C

NO

NC

C

NO

02 7 68

CH

L

H

L

H

L 1

25

4

3

7 68

C

1

28

7

6

5

4

3

Remote
control
input

Remote
control
input

Pulse 
input

Remote
control
input

Pulse 
input

Remote
control
input

Pulse 
input

Remote
control
input

Remote
control
input

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

FAIL

FAIL

Status 

FAIL
Status Status 

/F1 /R1 /A1 /PM1 /A2 /PM1

/A1 /F1 /PM1 /PM1 /F1 /PM1

NC

C

NO

NC

C

NO

CH

L

H

L

H

L 1

25

4

3

7 68

CH

L

H

L

H

L 1

25

4

3

7 68

/TPS4

++
-

+
-

+
--

++
-

+
-

+
--

++
-

+
-

+
--

4

/TPS8

3
4

4

3

4

Transmitter power supply

Transmitter power supply

Transmitter power supply
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/A4 /A4 /R1

/A3 /PM1

CH

L

H

L

H

L 1
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4

3

7 68

CH

L

H

L

H

L 1

25

4

3
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C
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NC

C

NO
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C
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C
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12 1114 1316 15
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C
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C
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C
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12 1114 1316 15
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C
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C

NO
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C
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C
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C
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C
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12 1114 1316 15
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NC

C
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C
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NC

C
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C
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C

NO
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C
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C

NO

12 1114 1316 15
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C

NO
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NC

C

NO

NC

C

NO

NC

C

NO
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C
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C
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C
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C
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C

1
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5
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02 0104 0306 05

C

1

28

7

6

5

4

3

02 0104 0306 05

1

1
2

2

1

2

1

2

1

2

1

2

1

2

Options That Use Option Terminal Blocks 1 and 2

These options can come with /TPS4 or /TPS8.
In that case, the option terminal block 4, or option terminal blocks 3 and 4 are installed.
For the terminal arrangement for /TPS4 and /TPS8, see page 57.
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input

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Remote
control
input
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control
input

Pulse 
input

Remote
control
input

Remote
control
inputFAIL

Status 
FAIL

Status 

FAIL
Status 
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/A4 /PM1

/A4 /F1 /R1
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Options That Use Option Terminal Blocks 1, 2, and 3

1

2

1

2

1

2

1

3

3

3

3

2

13
2

These options can come with /TPS4.
In that case, the option terminal block 4 is installed.
For the terminal arrangement for /TPS4, see page 57.
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NC

C

NO

32 3134 3336 35

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

32 3134 3336 35

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

32 3134 3336 35

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

32 3134 3336 35

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

22 2124 2326 25

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

22 2124 2326 25

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

12 1114 1316 15

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

02 0104 0306 05

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

02 0104 0306 05

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

12 1114 1316 15

C

1

28

7

6

5

4

3

C

1

28

7

6

5

4

3

/F2 /R1

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

12 1114 1316 15

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

02 0104 03

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

NC

C

NO

02 0104 03

13
24

Options That Use Option Terminal Blocks 1, 2, 3, and 4

1

2

1

2

1

2

1

2

3

4

3

4

3

4

3

4

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Alarm 
output

Remote
control
input

Remote
control
input

FAIL
Status 

FAIL
Status 
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Alarm Output Terminal (/A1, /A2, /A3, /A4, and /A5), FAIL Output Terminal, and 
Status Output Terminal (/F1 and /F2)

C
NC

NO

Output format: Relay contact
Contact rating: 250 VAC (50/60 Hz)/3 A, 
 250 VDC/0.1 A (for resistor load)
Withstand voltage: 1600 VAC at 50/60 Hz for one 
 minute (between output terminals 
 and the ground terminal)

NO C NC NO C NC NO C NC

NO C NC NO C NC NO C NC

FAIL 
output
(/F1, /F2)

Other 
output
(/F1, /F2)

During normal 
operation

When a failure 
occurs

When power is 
turned OFF

During normal 
operation

When specified 
status occurs

When power is 
turned OFF

Remote Control Input Terminal (/R1)

C C 
1 

1~ 8 

2 

3 
4 
5 

6 
7 
8 

• Transistor input (open collector) Internal circuit • Relay contact input  
 (voltage-free contact) 

C 
1 
2 

3 
4 
5 

6 
7 
8 

Withstand voltage: 1000 VDC for one minute between input terminals and the ground terminal

Input format: 
 Photocoupler isolation 
 Shared common (C) 
Allowable input voltage:  
5 VDC 

5 V Contact closed at 200 Ω or less
Contact open at 100 kΩ or greater

ON voltage: 0.5 V or less (30 mADC) 
Leakage current when turned OFF: 
 0.25 mA or less 

Pulse Input Terminal (/PM1)

H 
L 

H 
L H 

L 
H 
L 

H 
L 

H 
L 

H 
8 7 6 6 7 8 

L 

Withstand voltage: 1000 VDC for one minute between input terminals and the ground terminal

Input format: 
 Photocoupler isolation 
 Shared common (L) 
Allowable input voltage:  
 

5 V 
Internal circuit •Transistor input (open collector) • Relay contact input  

 (voltage-free contact) 
Contact closed at 200 Ω or less
Contact open at 100 kΩ or greater

ON voltage: 0.5 V or less (30 mADC) 
Leakage current when turned OFF: 
 0.25 mA or less 

30 VDC 

24 VDC Transmitter Power Supply Output Terminal (/TPS4 and /TPS8)
Connect the DX to the transmitter as shown below.

–

+

+

–

Transmitter

CurrentDX

Transmitter power 
supply output terminal

Input terminal

Shunt resistor: 250 Ω

To reduce noise, use a shielded cable for wiring.
Connect the shield to the functional ground
terminal or the ground terminal of the DX.

Note

Serial Interface
Connecting to the RS-232 Connector (/C2)

2 1 3 4 5

6 7 98

2 RD (Received Data):  Received data from the PC. Input signal to the DX.
3 SD (Send Data):  Transmitted data to the PC. Output signal from the DX.
5 SG (Signal Ground): Signal ground.
7 RS (Request to Send): Handshaking signal when receiving data from the PC. Output signal 
     from the DX.
8 CS (Clear to Send): Handshaking signal when transmitting data to the PC. Input signal to 
     the DX.
* Pins 1, 4, 6, and 9 are not used.

(male)

Connecting to the PROFIBUS-DP Connector (/CP1)
 RxD/TxD-P: Positive data input/output.
  CNTR-P: RTS (needed when using a repeater).
  DGND: Ground.
  VP +5V: +5 V.
  RxD/TxD-N: Negative data input/output.
* Pins 1, 2, 7, and 9 are not used.
** The DX does not have a built-in terminator. If you need to terminate the cable at the 

DX, use a terminated connector.

5 4 3 2 1

9 8 7 6
(female)

3
4
5
6
8

Installation and Wiring
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Connecting to the RS-422/485 (/C3)

FG (Frame Ground)  Frame ground of the DX.
SG (Signal Ground)  Signal ground.
SDB (Send Data B)  Send data B (+).
SDA (Send Data A)  Send data A (–).
RDB (Received Data B)  Receive data B (+).
RDA (Received Data A)  Receive data A (–).

FG SG SDB SDA RDB RDA

Electric 
potential 
of the shield

Two-wire system

Shield

FG SG SDB SDA RDB RDA

Electric 
potential 
of the shield

Four-wire system

Shield

Recommended length of stripped wire: 9 mm.  Recommended tightening torque: 0.4-0.5 N•m.

Cable
There are two types of cables available, the four-wire cable and the two-wire cable (used only for the Modbus protocol).
The cable should meet the following specifications.
• Type: Shielded twisted pair cable: 3 pairs 24 AWG or more (four-wire), 
  2 pair 24 AWG or more (two-wire)
• Characteristic impedance: 100 Ω
• Capacitance: 50 pF/m
• Total cable length: Up to 1.2 km

Connecting to the VGA Connector (/D5)

	 CAUTION
•	 Connect the cable after turning OFF the DX and the monitor.
•	 Do not short the VIDEO OUT terminal or apply external voltage to it. If you do, 

the DX may malfunction.

VGA Output Terminal

		
!VIDEO OUT(VGA)

The DX display can be output to a monitor through the RGB output. Connectable 
monitors are VGA monitors or multi-sync monitors capable of displaying VGA.

Specifications of the VGA Output Terminal
Pin No. Signal Name Specifications
1 Red 0.7 Vp-p
2 Green 0.7 Vp-p
3 Blue 0.7 Vp-p
4 –
5 –
6 GND
7 GND
8 GND
9 –
10 GND
11 –
12 –
13 Horizontal sync 

signal
Approx. 31.5 kHz, TTL 
negative logic

14 Vertical sync signal Approx. 60 Hz, TTL 
negative logic

15 –

Installation and Wiring
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D-Sub 15-pin receptacle
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Connecting to the Monitor
1.	 Turn OFF the DX and the monitor.
2.	 Connect the DX and the monitor using an analog RGB cable.
3.	 Turn ON the power to both the DX and the monitor. The DX screen is displayed 

on the monitor.

Note
•	 When the DX is turned ON, a VGA signal is always output from the VIDEO OUT terminal.
•	 The monitor screen may flicker if the DX or another instrument is brought close to the 

monitor.
•	 The edge of the screen may drop out depending on the monitor type.

Connecting to the USB Port (/USB1)
The USB port complies with Rev. 1.1.

		

POWER

CF CARD

USB port

USB port

RearFront

Connecting to the Ethernet Port

		

Ethernet port
Indicator

Do not connect an Ethernet cable whose plug does 
not comply with FCC specifications. If you do, the
DX may malfunction.

CAUTION

Checking the Connection/Communication Status
You can check the connection status of the Ethernet interface with the indicators that are 
located above the Ethernet connector of the DX.

Indicator Connection Status of the Ethernet Interface
Illuminated (green) The Ethernet interface is electrically connected.
Blinking (red) Transmitting data.
Off The Ethernet interface is not electrically connected.

Checking the Connection on the DX Display
•	 Checking the Connection at the status indication section of the DX display
	 You can check the connection status of the Ethernet interface on the Ethernet Link 

indicator located on the right side of the status display section of the basic setting 
mode display. The basic setting menu appears by pressing MENU to display the 
setting menu followed by FUNC for approximately 3 s.

•	 Checking the Connection Status in the Display Section in the Upper 
Right Corner of the Communication Log Display of the DX

	 You can check the connection status of the Ethernet interface on the Link indicator on 
the display section in the upper right corner of the communication log display.
Indicator Connection Status of the Ethernet Interface
Illuminated (green) The Ethernet interface is electrically connected.
Off The Ethernet interface is not electrically connected.

Installation and Wiring
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Power Supply Wiring
Panel Mount Type, or Desktop Type with /P1 Option (Models with /H5 and /P1 Options)

Precautions to Be Taken While Wiring the Power Supply
Make sure to follow the warnings below when wiring the power supply. To prevent electric 
shock and damage to the DX, observe the following warnings.

	 WARNING
•	 To prevent electric shock when wiring, ensure the main power supply is turned OFF.
•	 To prevent the possibility of fire, use 600 V PVC insulated wire (AWG20 to 16) or 

an equivalent wire for power wiring.
•	 Make sure to earth ground the protective earth terminal through a grounding 

resistance less than 100 Ω before turning ON the power.
•	 Use crimp-on lug with insulation sleeves (for 4-mm screws) for power supply 

wires and protective grounding wires.
•	 To prevent electric shock, make sure to close the transparent cover for the 

power supply wires.
•	 Make sure to provide a power switch (double-pole type) on the power supply line in 

order to separate the DX from the main power supply. Put an indication on this switch 
as the breaker on the power supply line for the DX and indications of ON and OFF.
Switch specifications 
	 Steady-state current rating: 1 A or more (other than /P1), 3 A or more (/P1). 
	 Inrush current rating: 60 A or more (other than /P1), 70 A or more (/P1). 
	 Use a switch complies with IEC60947-1, 3.

•	 Connect a fuse (between 2 A and 15 A) to the power line. Use a fuse approved 
by CSA (for the use in North America) or VDE (for the use in Europe).

•	 Do not add a switch or fuse to the ground line.

Use a power supply that meets the following conditions:
Item Other than /P1 /P1
Rated supply voltage 100 to 240 VAC 24 VDC/AC
Allowable power supply voltage range 90 to 132, 180 to 264 VAC 21.6V to 26.4 VDC/AC
Rated power supply frequency 50/60 Hz 50/60 Hz (for AC)
Allowable power supply frequency range 50/60 Hz ± 2% 50/60 Hz ± 2% (for AC)
Maximum power consumption 74 VA (100 V)/100 VA (240 V) 45 VA (for DC), 70VA (for AC)

Note
Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on 
the measurement accuracy.

Wiring Procedure
1.	 Turn OFF the power to the DX and open the transparent power terminal cover.
2.	 Wire the power cord and the protective ground cord to the power supply terminals. 

Use ring-tongue crimp-on lugs (designed for 4 mm screws). The proper torque for 
tightening the screw is 1.4 to 1.5 N•m (12.4 to 13.2 inch•lbs).

					   

Power cord

Functional ground terminal
Protective grounding cord

NL

AC~
60VA MAX50/60Hz

100-240V

Note
Do not wire the protective grounding 
cord to the functional ground terminal.

24V DC
24V AC 50/60Hz 45VA MAX

28VA MAX

Other than /P1 /P1
(24 VDC/AC power supply)

3.	 Replace the power terminal cover, and fasten it with screws.

Installation and Wiring
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Desktop Type (/H5[ ] Option)
Precautions to Be Taken While Connecting the Power Supply
Make sure to follow the warnings below when connecting the power supply. To prevent 
electric shock and damage to the DX, observe the following warnings.

	 WARNING
•	 Before connecting the power cord, ensure that the source voltage matches the 

rated supply voltage of the DX and that it is within the maximum rated voltage 
range of the provided power cord.

•	 Connect the power cord after checking that the power switch of the DX is turned 
OFF.

•	 To prevent electric shock or fire, be sure to use the power cord supplied by 
YOKOGAWA.

•	 Make sure to perform protective earth grounding to prevent electric shock. 
Connect the power cord of the desktop type to a three-prong power outlet with a 
protective earth terminal.

•	 Do not use an extension cord without protective earth ground. Otherwise, the 
protection function will be compromised.

Use a power supply that meets the following conditions:
Item Condition
Rated supply voltage 100 to 240 VAC
Allowable power supply voltage range 90 to 132, 180 to 264 VAC
Rated power supply frequency 50/60 Hz
Allowable power supply frequency range 50/60 Hz ± 2%
Maximum power consumption 74 VA (100V) and 100 VA (240 V)

Note
Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on 
the measurement accuracy.

Connection Procedure
1.	 Check that the power switch is OFF.

2.	 Connect the power cord plug to the power connector on the rear panel. (Use the 
power cord that comes with the package.)

					   

3.	 Check that the power outlet meets the conditions given in the table above and 
that the supply voltage is within the maximum rated voltage range of the power 
cord that comes with the package. Then, connect the other end of the power cord 
to the power outlet. The AC outlet must be of a three-prong type with a protective 
earth ground.

Installation and Wiring
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Recommended Replacement Periods for Worn Parts 
Maintenance

To preserve the reliability of the DX and to use the DX in a good condition for an 
extended time, it is recommended that periodic replacements be made on parts. The 
replacement parts may change to accommodate preventive maintenance over extended 
time. Be sure to check with your nearest YOKOGAWA dealer.
The following table shows the recommended replacement period for expendable parts. 
The replacement period shown here applies when the recorder is used under standard 
operating conditions. For the actual replacement period, consider the actual conditions 
of use. Replacement of parts will be carried out by a YOKOGAWA engineer or an 
engineer certified by YOKOGAWA. Contact your nearest YOKOGAWA dealer when such 
replacement is necessary.

Item Replacement 
period Name Part No. Quantity 

Used Notes

LCD 5 years BEZEL Assembly B8706GK 1 For DX2000, Style number H: 5
without /D5, /KB1, and /KB2 options

B8706KC 1 For DX2000, Style number H: 5
with /D5 option and without /KB1 and 
/KB2 options

B8706KD 1 For DX2000, Style number H: 5
without /D5 option and with /KB1 or /
KB2 options

B8706KE 1 For DX2000, Style number H: 5
with /D5 and /KB1 or /KB2 options

Battery 10 years Battery Assembly B8800ZK 1
Dust and water  
proof strip

5 years Packing B8706FY 1
5 years Key Case Assembly B8706BM 1 English specifications
5 years Key Case Assembly B8706BY 1 Japanese specifications

Aluminum 
electrolytic capacitor

5 years* Power Supply Assembly – 1
5 years* AD Assembly Depends on the model

*	 Replacement period at the upper limit of the normal operating temperature (50°C)
	 The replacement period varies depending on the operating temperature and the specifications of the DX.
	 The lower the operating temperature, the longer is the replacement period. For example, if the operating 
	 temperature is 30°C, it may be possible to use the parts for more than 10 years.

Note
•	 The LCD replacement period indicates the half life of the brightness when the brightness 

is set to the factory default setting. The half life is shortened as the brightness is set 
higher. The deterioration of brightness varies depending on the condition of use, and its 
determination is subjective. Consider these facts for determining the actual replacement 
period.

•	 The color of the LCD may become yellowish as time elapses. The discoloration tends to 
progress faster as the brightness is set higher.
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Setup Items and Default Values

The setup items and the default values in the setting mode are listed below. Enter the 
settings that you are using in the Setting column for your convenience.

Setting mode menu

		

Page 69
 Page 69 to 71
Page 72 to 73*

 Page 74*

Page 75
 
Page 76
 Pages 76 to 78
Page 79
 Page 79*

Page 80
 Page 80

Page 81*

 Page 81*

Page 81*

Page 76

End: On models with advanced security (/AS1 option) Page 80*

Page 81*

Page 81*

Page 81
 Page 81
Page 82
 Page 82
Page 82
 Page 82
Page 82*

 Page 82*

Page 82
Page 82

	 *: Options
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Basic setting mode menu

		

Page 83
 Page 83
Page 83
 Page 83*1

Page 84
 Page 84
Page 84*1

 Page 84

Communication (PROFIBUS-DP): 
On models with the PROFIBUS-DP Interface (/CP1 option).
Signature: On models with advanced security (/AS1 option)

Page 85
 Page 85
Page 85
 Page 86*2

Pages 86 to 87*2

 Page 88*1

Page 88
 Page 89 to 92
Page 93*1

 Page 94*1

Page 94

Page 95
 Page 95
Page 95
 Page 95

Page 94

Page 93*1

Page 85*1

	 1: Options
	 2: Displayed when the function is enabled in the Environment settings.

Setup Items and Default Values
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Setup Items in Setting Mode and Their Default Values
This section uses the following notations in tables.
*1:	This indicates functions that are available for release number 2 or later.
*2:	This indicates functions that are available for release number 3 or later.
*3:	This indicates functions that are available for release number 4 or later.

Menu tab*2

Date/Time > Time settings
Setup Item Selectable Range or Selections Default Value Setting
Time set – 2008/01/01*2 

00:00:00

Date/Time > Daylight Saving Time
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Start time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/

OCT/NOV/DEC
MAR

Start time > Day order 1st/2nd/3rd/4th/Last 2nd
Start time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Start time > Hour of the day Numerical value 2
End time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/

OCT/NOV/DEC
NOV

End time > Day order 1st/2nd/3rd/4th/Last 1st
End time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
End time > Hour of the day Numerical value 1

Meas channel > Range, Alarm
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH
Range > Mode

Channel number
Skip/Volt/TC/RTD/Scale/Delta/DI/
1-5V/Sqrt

001
Volt

Mode=Volt
Range
Span Lower
Span Upper

20mV/60mV/200mV/2V/6V/20V/50V
Depends on the range.
Depends on the range.

2V
–
–

Mode=TC
Range
Span Lower
Span Upper

R/S/B/K/E/J/T/N/W/L/U/WRe  
(Options may add additional settings.)
Depends on the range.
Depends on the range.

R
–
–

Mode=RTD
Range
Span Lower
Span Upper

Pt/JPt (Options may add additional settings.)
Depends on the range.
Depends on the range.

Pt
–
–

Mode=Scale
Type
Range
Span Lower
Span Upper
Scale Lower
Scale Upper
Unit

Volt/TC/RTD/DI
Depends on the type.
Depends on the range.
Depends on the range.
–30000 to 30000, decimal position: 0 to 4
–30000 to 30000, decimal position: 0 to 4
6 characters or less

Volt
–
–
–
0.00
200.00
–

Mode=Delta
Type
Range
Span Lower
Span Upper
Ref.CH

Volt/TC/RTD/DI
Depends on the type.
Depends on the range.
Depends on the range.
Meas channel number

Volt
–
–
–
–

Setup Items and Default Values
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Setup Item Selectable Range or Selections Default Value Setting
Mode=DI

Range
Span Lower
Span Upper

Level/Cont
0, 1
0, 1

Level
0
1

Mode=1-5V
Range
Span Lower
Span Upper
Scale Lower
Scale Upper
Unit
Low-cut

1-5V
0.800 to 5.200
0.800 to 5.200
–30000 to 30000, decimal position :0 to 4
–30000 to 30000, decimal position :0 to 4
6 characters or less
On/Off

1-5V
1.000
5.000
0.00
200.00
–
Off

Mode=Sqrt
Range
Span Lower
Span Upper
Scale Lower
Scale Upper
Unit
Low-cut
Low-cut value

20mV/60mV/200mV/2V/6V/20V/50V
Depends on the range.
Depends on the range.
–30000 to 30000, decimal position: 0 to 4
–30000 to 30000, decimal position: 0 to 4
6 characters or less
On/Off
0.0 to 5.0

–
–
0.00
200.00
–
Off
0.5

Alarm
1, 2, 3, 4
Type

Value
Relay
Number

Detect

On/Off
H:High/L:Low/h:delta H/l:delta L/R:rate H/
r:rate L/T:delayH/t:delayL
Numerical value
On/Off
I01/.../I06, I11/.../I16, I21/.../I26, 
I31/.../I36 (Depends on the option.)
S01/S02/S03/.../S29/S30
On/Off

Off
H

–
Off
I01

On

Meas channel > Tag, Memory sample, Alarm delay
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
First-CH, Last-CH Channel number 001
Tag > Comment*2 32 characters or less*2 –
Tag > No.*2 16 characters or less –
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10
With /AS1*3

The First-CH, Last-CH, Tag, and Memory sample items are the same as on a DX without the /AS1 option.
Alarm delay > Time 1 to 3600 when the unit is seconds. 1 to 24 when 

the unit is hours.
10

Alarm delay > Unit Hour/Sec Sec

Meas channel > Moving average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Moving average > On/Off On/Off Off
Moving average > Count 2 to 400 2

Setup Items and Default Values
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Meas channel > Color
Setup Item Selectable Range or Selections Default Value Setting
Group of channel 001-010, etc Depends on the model.
Color Red/Green/Blue/B.violet/Brown/Orange/ 

Y.green/Lightblue/Violet/Graly/Lime/Cyan/ 
Darkblue/Yellow/Lightgray/Purple/Black/Pink/ 
L.brown/L.green/Darkgray/Olive/DarkCyan/ 
S.green (24 colors)

Red to Gray 

Meas channel > Zone, Scale, Bar graph
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Zone > Lower
Zone > Upper

0 to 95
5 to 100

0
100

Scale > Position
Scale > Division

Off/1/2/3/4/5/6/7/8/9/10
4/5/6/7/8/9/10/11/12/C10

1
10

Bar graph > Base position
Bar graph > Division

Normal/Center/Lower*1/Upper*1

4/5/6/7/8/9/10/11/12
Normal
10

Meas channel > Partial
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
On/Off On/Off Off
Expand 1 to 99% 50
Boundary Span Lower+1digit to Span Upper-1digit 0.0000

Meas channel > Alarm mark, Color scale band
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Alarm mark > Mark kind
Alarm mark > Indicate on Scale
Alarm mark > Alarm mark color > Alarm 1 
Alarm mark > Alarm mark color > Alarm 2 
Alarm mark > Alarm mark color > Alarm 3 
Alarm mark > Alarm mark color > Alarm 4 

Alarm/Fixed
On/Off
Red/Green/.../S.green (24 colors)
Same as Alarm 1
Same as Alarm 1
Same as Alarm 1

Alarm
Off
Red
Orange
Orange
Red

Color scale band > Band area
Color scale band > Color
Color scale band > Display position > Lower
Color scale band > Display position > Upper

Off/In/Out
Auto*2/Red/Green/.../S.green (24 colors)
Measuring range
Measuring range

Off
Lime
0.0000
0.0100

Meas channel > Calibration correction
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Number of set points Off/2/3/4/5/6/7/8/9/10/11/12/13/14/15/16 Off
1 to n > MES val
1 to n > True val

Value in the measuring range/measured value
Measuring range

–
–

Setup Items and Default Values
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Math channel > Calculation expression, Alarm
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Math range > Math On/Off
Math range > Calculation expression
Math range > Span Lower
Math range > Span Upper
Math range > Unit

On/Off
120 characters or less
–9999999 to 99999999, decimal position: 0 to 4
–9999999 to 99999999, decimal position: 0 to 4
6 characters or less

Off
–
–200.00
200.00
–

Math alarm
1, 2, 3, 4
Type
Value
Relay On/Off
Number 
 

Detect

On/Off
H:High/L:Low/T:delayH/t:delayL
Numerical value
On/Off
I01/.../I06, I11/.../I16, I21/.../I26,  
I31/.../I36 (Depends on the option.) 
S01/S02/S03/.../S29/S30
On/Off

Off
–
–
Off
I01 
 

On

Math channel > Constant
Setup Item Selectable Range or Selections Default Value Setting
Number of constant K01 to K60 K01
Value –9.9999E+29 to –1.0000E–30, 0,

1.0000E–30 to –9.9999E+29
1

Math channel > Tag, Memory sample, Alarm delay
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Tag > Comment*2 32 characters or less –
Tag > No.*2 16 characters or less –
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10

Math channel > TLOG, Rolling average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
TLOG > Timer type*2

TLOG > Timer No. 
 

TLOG > Sum scale
TLOG > Reset

Timer/Match T
1/2/3/4 
1/2/3/.../11/12 (on models with the /BT2 multi 
batch option)*2

Off, /s, /min, /h
On/Off

Timer
1 
 

Off
Off

Rolling average > On/Off
Rolling average > Interval 
 

Rolling average > Number of 
samples

On/Off
1s/2s/3s/4s/5s/6s/10s/12s/15s/20s/30s/ 
1min/2min/3min/4min/5min/6min/10min/12min/ 
15min/20min/30min/1h
1 to 1500

Off
10s 
 

1

Math channel > Color
Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Zone, Scale, Bar graph
Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Partial
Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Alarm mark, Color scale band
Setup items and values are the same as those for measurement channels, except the channel numbers.

Setup Items and Default Values
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Math channel > Math start action
Setup Item Selectable Range or Selections Default Value Setting
Math start action > Math start Off/Start/Rst+St Start

Setup Items and Default Values
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Ext. channel > Range, Alarm
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 201
Ext. range > On/Off
Ext. range > Span Lower
Ext. range > Span Upper
Ext. range > Unit

On/Off
–30000 to 30000, decimal position: 0 to 4 
–30000 to 30000, decimal position: 0 to 4
6 characters or less

Off
–200.00
200.00
–

Ext. alarm
1, 2, 3, 4
Type
Value
Relay On/Off
Number 
 

Detect

On/Off
H:High/L:Low/T:delayH/t:delayL
Numerical value
On/Off
I01/.../I06, I11/.../I16, I21/.../I26, 
I31/.../I36 (Depends on the option.) 
S01/S02/S03/.../S29/S30
On/Off

Off
–
–
Off
I01 
 

On

Ext. channel > Color
Setup items and values are the same as those for measurement channels, except the channel numbers.

Ext. channel > Zone, Scale, Bar graph
Setup items and values are the same as those for measurement channels, except the channel numbers.

Ext. channel > Partial, Alarm mark, Color scale band
Setup items and values are the same as those for measurement channels, except the channel numbers.

Setup Items and Default Values
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Display > Trend (Circular)/Save interval
Setup Item Selectable Range or Selections Default Value Setting
Trend/Save interval

Trend interval [/div] 

Save interval
Second interval [/div]

5s*2/10s*2/15s/30s/1min/2min/5min/10min/15min/
20min/30min/1h/2h/4h/10h (Depends on the model.)
10min to 31day (Depends on the trend interval.)
5s*2/10s*2/15s/30s/1min/2min/5min/10min/15min/
20min/30min/1h/2h/4h/10h (Depends on the model.)

1min 

1h
1min

Circular/Save interval
Time per revolution [/rev] 

Save interval
Offset time

20min/30min/1h/2h/6h/8h/12h/16h/1day/ 
2day/1week/2week/4week
10min to 31day (Depends on the time per revolution.)
Off/1h to 23h (Depends on the time per revolution.)

1day 

1h
Off

Display > Trend (Circular), Bar graph, LCD, Monitor
Setup Item Selectable Range or Selections Default Value Setting
Trend

Trend > Direction
Trend > Trend clear
Trend > Message direction
Trend > Scale > Digit
Trend > Scale > Value indicator
Trend > Trend line
Trend > Grid

Horizontal/Vertical/Wide/Split
On/Off
Horizontal/Vertical
Normal/Fine
Mark/Bargraph
1/2/3
Auto/4/5/6/7/8/9/10/11/12

Horizontal
Off
Horizontal
Normal
Mark
2
Auto

Circular
Circular > Full circle action
Circular > Trend line
Circular > Grid

Allclear/Divclear
1/2/3
Auto/4/5/6/7/8/9/10/11/12

Allclear
2
Auto

Bar graph > Direction Horizontal/Vertical Vertical
LCD > Brightness
LCD > Backlight saver > Mode
LCD > Backlight saver > Saver time
LCD > Backlight saver > Restore

1/2/3/4/5/6
Off/Dimmer/Timeoff
1min/2min/5min/10min/30min/1h
Key, Key+Alarm

2
Off
1h
Key+Alarm

Monitor > Background > Display
Monitor > Background > Historical trend
Monitor > Scroll time
Monitor > Jump default display

White/Black
White/Cream/Black/Lightgray
5s/10s/20s/30s/1min 
Off/1min/2min/5min/10min/20min/30min/1h

White
Black
10s
Off

Display > Annunciator*2

Setup Item Selectable Range or Selections Default Value Setting
Annunciator position 1 to 80 1
On/Off On/Off Off
Channel Channel number 001
Level 1 /2/3/4/All 1
Comment txt block No. 1 to 100 1

Display > FAVORITE Key action*2

Setup Item Selectable Range or Selections Default Value Setting
Action History/Favorite Favorite
Group display Current/Saved Saved
Time axis zoom Current/Saved Saved

Setup Items and Default Values
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Group set, Trip line
Setup Item Selectable Range or Selections Default Value Setting
Group number 1/2/3/.../35/36 1
Group set > On/Off

Group set > Group name
Group set > CH set

On/Off

16 characters or less
39 characters or less

Group 1 to 4: On
Group 5 to 36: Off
GROUP1 etc.
Depends on the model.

Trip line > 1
Trip line > 2
Trip line > 3
Trip line > 4
Trip line > Position
Trip line > Color 

Trip line > Line width

On/Off
On/Off
On/Off
On/Off
0 to 100
Red/Green/.../S.green (24 colors) 

1/2/3

Off
Off
Off
Off
50
1:Red, 2:Green 
3:Blue, 4:Yellow
2

Message, Comment Text*2 > Message
Setup Item Selectable Range or Selections Default Value Setting
Message No. 1-10/11-20/21-30/31-40/41-50/51-60/

61-70/71-80/81-90/91-100
11-20*3

1 to 100 32 characters or less –

Message, Comment Text > Comment text fields*2

Setup Item Selectable Range or Selections Default Value Setting
Coment txt field no 1 to 200 1
Text info 32 characters or less –

Message, Comment Text > Comment text block*2

Setup Item Selectable Range or Selections Default Value Setting
Coment txt block no 1 to 100 1
Line > 1 > Comment txt field no 1 to 200 1
Line > 2 > Comment txt field no 1 to 200 1
Line > 3 > Comment txt field no 1 to 200 1
Line > 4 > Comment txt field no 1 to 200 1
Line > 5 > Comment txt field no 1 to 200 1

Timer, Event action > Timer
Setup Item Selectable Range or Selections Default Value Setting
Timer No. 1/2/3/4

1/2/3/.../11/12 (on models with the /BT2 multi 
batch option)*2

1

Mode Off/Relative/Absolute Off
Relative > Interval
Relative > Reset at Math Start

00:01 to 24:00
On/Off

01:00
On

Absolute > Interval

Absolute > Ref.time

1min/2min/3min/4min/5min/6min/10min/
12min/15min/20min/30min/1h/2h/3h/4h/
6h/8h/12h/24h
0 to 23

1h

0:00

Setup Items and Default Values



77

Installation and W
iring

R
ecom

m
ended R

eplacem
ent 

Periods for W
orn Parts

Setup Item
s and 

D
efault Values

IM 04L42B01-02E

Timer, Event action > Match time timer
Setup Item Selectable Range or Selections Default Value Setting
Timer number 1/2/3/4

1/2/3/.../11/12 (on models with the /BT2 multi 
batch option)*2

1

Kind Off/Day/Week/Month Off
Day 1 to 31 (varies depending on the month) 1
Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Hour 00:00 to 23:59 00:00
Timer action Single/Repeat Repeat

Timer, Event action > Event action
Setup Item Selectable Range or Selections Default Value Setting
Logic box number 1/2/3/.../39/40 1
Event None/Remote/Relay/Switch/Timer/ 

Matchtime/Alarm/UserKey/ 
EventLevelSwitch*2/EventEdgeSwitch*2/ 
Relay-Off*3/Switch-Off*3/Alarm-Off*3/ 
EventLevelSwitch-Off*3

None

Remote > Remote number 1/2/3/4/5/6/7/8 1
Relay > Relay number I01/.../I06, I11/.../I16, I21/.../I26, I31/.../I36,  

(Depends on the option.)
I01/.../I06, I11/.../I16, I21/.../I26, I31/.../I36,  
(Depends on the option.)

I01

Switch > Switch No. S01/S02/S03/.../S29/S30 S01
Timer > Timer No. 1/2/3/4

1/2/3/.../11/12 (on models with the /BT2 multi  
batch option)*2

1

MatchTimeTimer > Match Time Timer No. 1/2/3/4
1/2/3/.../11/12 (on models with the /BT2 multi  
batch option)*2

1

EventLevelSwitch > Event Switch No*2 1/2/3/.../29/30 1
EventEdgeSwitch > Event Switch No*2 1/2/3/.../29/30 1
Relay-Off > Relay number*3 I01/.../I06, I11/.../I16, I21/.../I26, I31/.../I36 

(Depends on the option.)
I01

Switch-Off > Switch No.*3 S01/S02/S03/.../S29/S30 S01
EventLevelSwitch-Off > Event Switch No*3 1/2/3/.../30 1

Setup Items and Default Values
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Setup Item Selectable Range or Selections Default Value Setting
Action 
 
 
 
 
 
 
 
 
 
 
Message > Message No.

Message > Write to
Message > Group number
Group > Group number
FavoriteDisplay > Action*2

FavoriteDisplay > Select  
> Favorite Screen No*2

CommentDisplay  
> Comment Txt Block No*2

Flag > Flag number
TimerReset > Timer No. 
 

PanelLoad > Setting file number

MemoryStart/Stop, MemoryStart, MemoryStop, 
Trigger (not selectable on a DX with the /AS1 
option*3), AlarmACK, AlarmDisplayReset*2,  
MathStart/Stop, MathStart, MathStop,  
MathReset, SaveDisplay, SaveEvent, Message,  
Snapshot, DisplayRate1/2, ManualSample,  
TimerReset, DisplayGroupChange,  
FavoriteDisplay*2, CommentDisplay*2, Flag,  
PanelLoad (not selectable on a DX with the /AS1 
option*3), TimeAdjust (Depends on the events, 
etc)
1 to 100
All/Select
1/2/3/.../35/36
1/2/3/.../35/36
Key/Select
 
1/2/3/4/5/6/7/8
 
1 to 100
1/2/3/4/5/6/7/8
1/2/3/4 
1/2/3/.../11/12 (on models with the /BT2 multi  
batch option)*2

1/2/3

Group 
 
 
 
 
 
 
 
 
 
  
1
All
1
1
Key
 
1
 
1
1
1 
 

1

The following menus appear when the multi batch function*2 is in use.
MemoryStart/Stop > Target Action
MemoryStart/Stop > Select  
> Batch Group No
MemoryStart > Target Action
MemoryStart > Select  
> Batch Group No
MemoryStop > Target Action
MemoryStop > Select  
> Batch Group No
SaveDisplay > Target Action
SaveDisplay > Select  
> Batch Group No
SaveEvent > Target Action
SaveEvent > Select  
> Batch Group No
MathReset > Target Action
MathReset > Select  
> Batch Group No
Message > Message No.
Message > Write to
Message > Select  
> Batch Group No 
> Display Group No
Message > All 
> Batch Group No
DisplayGroupChange  
> Batch Group No
DisplayGroupChange  
> Display Group No

All/Select
 
1/2/3/.../11/12 (varies depending on settings)
All/Select
 
1/2/3/.../11/12 (varies depending on settings)
All/Select
 
1/2/3/.../11/12 (varies depending on settings)
All/Select
 
1/2/3/.../11/12 (varies depending on settings)
All/Select
 
1/2/3/.../11/12 (varies depending on settings)
All/Select
 
1/2/3/.../11/12 (varies depending on settings)
1 to 100
All/Select
 
1/2/3/.../11/12 (varies depending on settings) 
1/2/3/.../11/12
 
1/2/3/.../11/12 (varies depending on settings)
 
1/2/3/.../11/12 (varies depending on settings)
 
1/2/3/.../11/12

All
 
1
All
 
1
All
 
1
All
 
1
All
 
1
All
 
1
1
All
 
1 
1
 
1
 
1
 
1
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Data save > File header, Data file name
Setup Item Selectable Range or Selections Default Value Setting
File header > Characters 50 characters or less –
Data file name > Structure Date/Serial/Batch Date
Data file name > Identified strings 16 characters or less –

Data save > Save directory
Setup Item Selectable Range or Selections Default Value Setting
Directory name 20 characters or less DATA0

Data save > Event data
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Sample rate 25ms/125ms/250ms/500ms/1s/2s/5s/10s/30s/

60s/120s/300s/600s/15min*2/20min*2/30min*2

 (Depends on the model.) 

1s

Mode Free/Single/Repeat Free
Data length 10min to 31day (Depends on the sample rate.) 1h
Pre-trigger 0/5/25/50/75/95/100 0
Trigger signal > Key On/Off On
With /AS1*3

The Sample rate and Data length items are the same as on a DX without the /AS1 option.
Mode Fixed at Free Free
There are no Pre-trigger or Trigger signal > Key items.

Data save > Manual sample
Setup Item Selectable Range or Selections Default Value Setting
Manual sample number 001 to 120 001
On/Off On/Off On
Channel Channel number 001

Data save > Batch text
Setup Item Selectable Range or Selections Default Value Setting
Text field number 1 to 24*2 1
Text field > Title of field
Text field > Characters

20 characters or less
30 characters or less

–
–

Web Report*2

Setup Item Selectable Range or Selections Default Value Setting
Web Report No 1/2/3/4/5/6/7/8/9/10 1
On/Off On/Off Off
Title 64 characters or less –
Item > 1 to 10 On/Off Off
Item > 1 to 10 > Report CH R01/R02/.../R60 R01
Item > 1 to 10 > Value Max/Min/Ave/Sum/Inst Sum
Item > 1 to 10 > Name 16 characters or less –

Setup Items and Default Values
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Menu customize
Setup Item Selectable Range or Selections Default Value Setting
Function menu Select/Hide/View/Transfer –
Display menu Separate/Select/Hide/View/Transfer –

End (/AS1 option)*3

Setup Item Selectable Range or Selections Default Value Setting
End Yes/No –

Basic setting mode*2

Setup Item Selectable Range or Selections Default Value Setting
Entering basic setting mode. ... Yes/No –

Setup Items and Default Values
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Multi batch tab*2

Group set, Trip line > Group set*2

Setup Item Selectable Range or Selections Default Value Setting
First Batch Group No, Last Batch Group No. 1/2/3/4/5/6/7/8/9/10/11/12 (varies 

depending on settings)
1

Display Group No 1/2/3/4/5/6/7/8/9/10/11/12 1
Set Display Group > On/Off
Set Display Group > Group name
Set Display Group > CH set

On/Off
16 characters or less
39 characters or less

Off
BATCH-1, etc.
Depends on the model.

Trip line
1, 2, 3, 4
Position
Color 

Line Width

On/Off
0 to 100
Red/Green/.../S.green (24 colors) 

1/2/3

Off
50
1:Red, 2:Green 
3:Blue, 4:Yellow
2

File header, File name*2

Setup Item Selectable Range or Selections Default Value Setting
First Batch Group No, Last Batch Group No. 1/2/3/.../11/12 (varies depending on settings) 1
File header > Characters 50 characters or less –
Data file name > Structure Date/Serial/Batch Date
Data file name > Identified strings 16 characters or less –

Data save > Batch text*2

Setup Item Selectable Range or Selections Default Value Setting
First Batch Group No, Last Batch Group No. 1/2/3/.../11/12 (varies depending on settings) 1
Text field number 1 to 24 1
Text field > Title of field 20 characters or less –
Text field > Characters 30 characters or less –

End (/AS1 option)*3

Setup Item Selectable Range or Selections Default Value Setting
End Yes/No –

Set Calibration Tab*3

Setup Item Selectable Range or Selections Default Value Setting
Calibration correction Same as Meas channel > Calibration correction
Finish Calibration > Next calibration due Year, month, and date –
Finish Calibration > Execute – –

End (/AS1 option)*3

Setup Item Selectable Range or Selections Default Value Setting
End Yes/No –

File tab*2

Load display data
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Load event data
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Setup Items and Default Values
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Load settings
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Save settings
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
File name 32 characters or less –

Custom display load > Select*2

Setup Item Selectable Range or Selections Default Value Setting
Display No. Internal 1 to Internal 3, External 1 to External 25 Internal 1
File selection screen – –

Custom display load > All*2

Setup Item Selectable Range or Selections Default Value Setting
Directory selection screen – –

Custom display save > Select*2

Setup Item Selectable Range or Selections Default Value Setting
Display No. Internal 1 to Internal 3, External 1 to External 25 Internal 1
File name 32 characters or less –

Custom display save > All*2

Setup Item Selectable Range or Selections Default Value Setting
Directory name 20 characters or less –

File list/delete (Delete is not available on DXs with the /AS1 option.*3)
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Load template*3

Setup Item Selectable Range or Selections Default Value Setting
Report Kind Hour, Day, Week, Month, Hour+Day, Day+Week, 

Day+Month
–

Save template*3

Setup Item Selectable Range or Selections Default Value Setting
Report Kind Hour, Day, Week, Month, Hour+Day, Day+Week, 

Day+Month
–

Template data save > File name 32 characters or less –

Format (Without /AS1)
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
Format > Volume name 11 characters or less –

End (/AS1 option)*3

Setup Item Selectable Range or Selections Default Value Setting
End Yes/No –

Setup Items and Default Values
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Setup Items in Basic Setting Mode and Their Default Values
This section uses the following notations in tables.
*1:	This indicates functions that are available for release number 2 or later.
*2:	This indicates functions that are available for release number 3 or later.
*3:	This indicates functions that are available for release number 4 or later.

Environment tab*2

Operating environment
Setup Item Selectable Range or Selections Default Value Setting
Tag/Channel Tag/Channel Tag
Language English/Japanese/German/French/Chinese English
Remote Controller ID Off/0/1/.../30/31 Off
Temperature C/F C
Decimal Point Type*2 Point/Comma Point
Basic setting mode Menu display*2 On/Off On

View, Message, Input, Tag*2

Setup Item Selectable Range or Selections Default Value Setting
View > Trend type
View > Partial
View > Trend rate switching

T-Y/Circular
On/Off
On/Off

T-Y
Off
Off

Message > Write group
Message > Power-fail message
Message > Change message

Common/Separate
On/Off
On/Off

Common
Off
Off

Input > Value on over-range Free/Over Over
Tag Basic settings > Tag No. Use/Not*2 Use/Not Not

Alarm > Action*2

Setup Item Selectable Range or Selections Default Value Setting
No logging On/Off Off
Annunciator mode*2

Sequence*2

Time off color*2

On/Off
ISA-A-4/ISA-A/ISA-M
White/Green

Off
ISA-A
Green

Alarm > Level/Color*2

Setup Item Selectable Range or Selections Default Value Setting
Level 1-2-3-4/1-4-2-3/1-4-3-2 1-2-3-4
Color > 1
Color > 2
Color > 3
Color > 4

Red/Yellow/Orange/Pink
Red/Yellow/Orange/Pink
Red/Yellow/Orange/Pink
Red/Yellow/Orange/Pink

Red
Red
Red
Red

Remote*2

Setup Item Selectable Range or Selections Default Value Setting
Level 1-2-3-4/1-4-2-3/1-4-3-2 1-2-3-4
Remote Input > 1
Remote Input > 2
Remote Input > 3
Remote Input > 4
Remote Input > 5
Remote Input > 6
Remote Input > 7
Remote Input > 8

N.O/N.C
N.O/N.C
N.O/N.C
N.O/N.C
N.O/N.C
N.O/N.C
N.O/N.C
N.O/N.C

N.O
N.O
N.O
N.O
N.O
N.O
N.O
N.O

Setup Items and Default Values
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Security, Media save, Batch
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Security > Key
Security > Communication

Off/Login/Keylock
Off/Login

Off
Off

Save > Auto save
Save > Media FIFO*1

On/Off
On/Off

On
Off

Batch > On/Off
Batch > Lot-No. digit
Batch > Auto increment
Batch operation qty*2

On/Off/MultiBatch*2

Off/4/6/8
On/Off
2/3/4/5/6/7/8/9/10/11/12

Off (With /AS1, On)
6
On
4

With /AS1*3

Security > Key Login Login
Security > Communication Off/Login Off
Security > Multi login On/Off Off
Security > Password management On/Off Off
The Save items are the same as on a DX without the /AS1 option.
The Batch items are the same as on a DX without the /AS1 option.

Communication > Service port
Setup Item Selectable Range or Selections Default Value Setting
FTP 1 to 65535 21
HTTP 1 to 65535 80
SNTP 1 to 65535 123
Modbus 1 to 65535 502

Communication > POP3 Details*2

Setup Item Selectable Range or Selections Default Value Setting
POP Before SMTP > Send delay [second] 0/1/2/3/4/5/6/7/8/9/10 2
POP3 Login PLANE/APOP PLAIN

Communication > FTP Server Details*2

Setup Item Selectable Range or Selections Default Value Setting
Output Directory Format MS-DOS/UNIX MS-DOS

Math, Report
Setup Item Selectable Range or Selections Default Value Setting
Math > Value on Error
Math > Value on Overflow > SUM, AVE
Math > Value on Overflow > MAX, MIN, P-P

+Over/–Over
Error/Skip/Limit
Over/Skip

+Over
Skip
Over

Report > Report select > 1
Report > Report select > 2
Report > Report select > 3
Report > Report select > 4
Report > File type
Report > Use Template*3

Max/Min/Ave/Sum/Inst
Off/Max/Min/Ave/Sum/Inst
Off/Max/Min/Ave/Sum/Inst
Off/Max/Min/Ave/Sum/Inst
Separate/Combine/Separate2*3

Use/Not

Ave
Max
Min
Sum
Separate
Not

End
Setup Item Selectable Range or Selections Default Value Setting
Do you want to store and 
make the new settings take effect?

Yes/No/Cancel –

Setup Items and Default Values
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Menu tab*2

Alarm
Setup Item Selectable Range or Selections Default Value Setting
Basic setting

Reflash
Rate of change > Decrease
Rate of change > Increase
Indicator

On/Off/On-1s*3/On-2s*3

1 to 32
1 to 32
Hold/Nonhold

Off
1
1
Nonhold

Switch, Relay
Internal Switch > AND
Relay > AND
Relay > Action
Relay > Hold

Relay > Relay Action on ACK*1

None/S01/S01-S02/.../S01-S29/S01-S30
None/I01/I01-I02/.../I01-I35/I01-I36
Energize/De_energ
Hold/Nonehold
Normal/Reset

None
None
Energize
Nonhold
Normal

Hysteresis
Meas CH > High/Low
Meas CH > Delta High/Low
Math CH > High/Low
Ext. CH > High/Low

0.0 to 5.0
0.0 to 5.0
0.0 to 5.0
0.0 to 5.0

0.5
0.0
0.0
0.0

A/D, Memory
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Scan interval > Scan mode

Normal > Scan interval 
 

Normal > A/D integrate
Fast †> Scan interval 

 

Fast †> A/D integrate

Normal/Fast
125ms/250ms(DX2004, DX2008) 
1s/2s/5s(DX2010, DX2020, DX2030, DX2040, 
DX2048)
Auto/50Hz/60Hz/100ms
25ms (DX2004, DX2008) 
125ms (DX2010, DX2020, DX2030, DX2040,  
DX2048)
600Hz

Normal
125ms 
1s 

Auto
25ms 
125ms 

600Hz
Memory > Data kind Display/E+D/Event Display
With /AS1*3

The Scan interval items are the same as on a DX without the /AS1 option.
Memory > Data kind Display/Event Display
†: You cannot select this option on a DX with external input channels (/MC1) or when the multi batch function (/BT2) is in use.

Signature (/AS1 option)*3

Setup Item Selectable Range or Selections Default Value Setting
Process type Batch/Continue Batch
Sign from recorder Off/Sign1/Sign1+2/Sign1+2+3 Off
Signature at batch stop On/Off Off
FTP transfer at signing On/Off Off

Burnout, RJC
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Burnout set > Mode Off/Up/Down Off
RJC > Mode
RJC > Volt

Internal/External
–20000 to 20000µV

Internal
0

Setup Items and Default Values
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Keylock (Without /AS1)
Setup Item Selectable Range or Selections Default Value Setting
Password 8 characters or less –
Key action > START
Key action > STOP
Key action > MENU
Key action > USER
Key action > DISP/ENTER
Key action > FAVORITE

Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock

Free
Free
Free
Free
Free
Free

Media/USB > External media
Media/USB > Load settings

Free/Lock
Free/Lock

Free
Free

Action of Function > AlarmACK
Action of Function > Message/Batch
Action of Function > Math
Action of Function > Data save
Action of Function > E-mail/FTP
Action of Function > Time set
Action of Function > Display Function

Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock

Free
Free
Free
Free
Free
Free
Free

Login > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Auto logout Off/1min/2min/5min/10min Off
Operation without Login Off/Display Off
With /AS1*3

Auto logout Off/1min/2min/5min/10min Off
Operation without Login Off/Display Off
User ID Use/Not Use
Password retry frequency 3/5/Off 3
Root password > Password 20 characters or less ????????

Login > Admin settings
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Admin number 1 to 5 1
Mode
User name
Password

Off/Key/Web/Key+Comm
20 characters or less
20*3 characters or less

Off
Admin1 etc.
????????

With /AS1*3

Admin number 1 to 5 1
Mode Off/Key/Web/Key+Comm Off
User name 20 characters or less Admin1 etc.
User ID 8 characters or less –
Password 20 characters or less ????????
Password expire Off/1month/3month/6month Off

Setup Items and Default Values
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Login > User settings
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
User number 1 to 30 1
Mode
User name
Password
Authority of user

Off/Key/Comm/Web/Key+Comm
20 characters or less
20*3 characters or less
Off/1/2/3/4/5/6/7/8/9/10

Off
User1 etc.
????????
Off

With /AS1*3

User number 1 to 90 1
Mode Off/Key/Comm/Web/Key+Comm Off
User name 20 characters or less User1 etc.
User ID 8 characters or less –
Password 20 characters or less ????????
Password expire Off/1month/3month/6month Off
Authority of user Off/1/2/3/4/5/6/7/8/9/10 Off

Login > Authority of user > Key action, Media
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Authority of user 1/2/3/4/5/6/7/8/9/10 1
Key action > START
Key action > STOP
Key action > MENU
Key action > USER
Key action > DISP/ENTER
Key action > FAVORITE

Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock

Free
Free
Free
Free
Free
Free

Media/USB > External media
Media/USB > Load settings*2

Free/Lock
Free/Lock

Free
Free

Authority of user
Action of Function > AlarmACK
Action of Function > Message/Batch
Action of Function > Math
Action of Function > Data save
Action of Function > E-mail/FTP
Action of Function > Time set
Action of Function > Display Function

1/2/3/4/5/6/7/8/9/10
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock

1
Free
Free
Free
Free
Free
Free
Free

With /AS1*3

The Authority of user, Key action, and Media/USB items are the same as on a DX without the /AS1 option.
Actions > AlarmACK Free/Lock Free
Actions > Message/Batch Free/Lock Free
Actions > Math Free/Lock Free
Actions > Data save Free/Lock Free
Actions > E-mail/FTP Free/Lock Free
Actions > Time set Free/Lock Free
Actions > Display Function Free/Lock Free
Action > Calibration Free/Lock Free
Sign record > Signature1 Free/Lock Free
Sign record > Signature2 Free/Lock Free
Sign record > Signature3 Free/Lock Free

Setup Items and Default Values
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Report > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Report kind Off/Hour/Day/Hour+Day/Day+Week/Day+Month Off
Date 1 to 28 1
Day of the week (Day+week) SUN/MON/TUE/WED/THU/FRI/SAT SUN
Time (hour) 0 to 23 0:00

Report > Report settings
Setup Item Selectable Range or Selections Default Value Setting
Report channel number R01/R02/R03/.../R59R60 R01
On/Off On/Off Depends on the model
Channel Channel number 001 etc.
Sum scale Off, /s, /min, /h, /day /s

Time settings
Setup Item Selectable Range or Selections Default Value Setting
Time zone (HHMM)
Time deviation limit
Date format

–1300 to 1300
Off/10s/20s/30s/1min/2min/3min/4min/5min
Y/M/D, M/D/Y, D/M/Y, D.M.Y

900
30s
Y/M/D

Calender display > 1st weekday*2 SUN/MON MON

Setup Items and Default Values
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Setup Items and Default Values

Communication (Ethernet) > IP-address, Host settings
Setup Item Selectable Range or Selections Default Value Setting
DHCP Use/Not Not
DNS accession Use/Not Use
Host-name register Use/Not Use
Fixed IP-address > IP-address
Fixed IP-address > Subnet mask
Fixed IP-address > Default gateway

0.0.0.0 to 255.255.255.255
0.0.0.0 to 255.255.255.255
0.0.0.0 to 255.255.255.255

0.0.0.0
0.0.0.0
0.0.0.0

Host settings > Host name 64 characters or less –
Host settings > Domain name 64 characters or less –

Communication (Ethernet) > DNS settings
Setup Item Selectable Range or Selections Default Value Setting
Server search order > Primary
Server search order > Secondary

0.0.0.0 to 255.255.255.255
0.0.0.0 to 255.255.255.255

0.0.0.0
0.0.0.0

Domain suffix search order > Primary
Domain suffix search order > Secondary

64 characters or less
64 characters or less

–
–

Communication (Ethernet) > Keep alive, Application time out
Setup Item Selectable Range or Selections Default Value Setting
Keep alive On/Off On
Application time out > On/Off
Application time out > Time

On/Off
1 to 120 (min)

Off
1

Communication(Ethernet) > Server > Server modes
Setup Item Selectable Range or Selections Default Value Setting
FTP Use/Not Use*2

Web Use/Not Use*1

SNTP Use/Not Not
Modbus Use/Not Not
PLC communication protocol*2 Use/Not Not

Communication(Ethernet) > Server > Allowed Modbus clients*2

Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Client number 1/2/3/4/5/6/7/8/9/10 1
On/Off On/Off Off

Communication (Ethernet) > Web page
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Page type Operator/Monitor Operator
Page type=Operator

Web page > On/Off
Web page > Access control
Web page > Command

On/Off
Off/Admin
Use/Not

Off
Off
Not

Page type=Monitor
Web page > On/Off
Web page > Access control

On/Off
Off/Admin/User

Off
Off

With /AS1*3

Page type Operator/Monitor Operator
Page type=Operator

Web page > On/Off On/Off Off
Web page > Access control Off/Admin Off

The items when Page type is set to Monitor are the same as on a DX without the /AS1 option.
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Setup Items and Default Values

Communication (Ethernet) > E-Mail > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
SMTP server name
Port number
Security*2

64 characters or less
0 to 65535
Off/PbS*2/Auth*3

–
25
Off

SMTP authorization > User name  
(when Auth is selected)*3

32 characters or less –

SMTP authorization > Password  
(when Auth is selected)*3

32 characters or less –

Communication (Ethernet) > E-Mail > Recipients
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 150 characters or less –
Recipient 2 150 characters or less –
Sender 64 characters or less –

Communication (Ethernet) > E-Mail > POP3 settings*2

Setup Item Selectable Range or Selections Default Value Setting
POP3 Server name 64 characters or less –
Port number 0 to 65535 110
Login name 32 characters or less –
Password 32 characters or less ******...***

Communication (Ethernet) > E-Mail > Alarm settings
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off
Recipient 2 On/Off Off
Active Alarms > Alarm 1
Active Alarms > Alarm 2
Active Alarms > Alarm 3
Active Alarms > Alarm 4

On/Off
On/Off
On/Off
On/Off

Off
Off
Off
Off

Include INST
Include source URL
Subject
Header 1
Header 2

On/Off
On/Off
32 characters or less
64 characters or less
64 characters or less

Off
Off
Alarm_summary
–
–

Send alarm action*2 On+Off/On On+Off
Include tag/ch in Subject*2 On/Off Off

Communication (Ethernet) > E-Mail > Scheduled settings
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1
Interval
Ref.time 
Recipient 2
Interval
Ref.time

On/Off
1h/2h/3h/4h/6h/8h/12h/24h
00:00 to 23:59
On/Off
1h/2h/3h/4h/6h/8h/12h/24h
00:00 to 23:59

Off
24h
00:00
Off
24h
00:00

Include INST
Include source URL
Subject
Header 1
Header 2

On/Off
On/Off
32 characters or less
64 characters or less
64 characters or less

Off
Off
Periodic_data
–
–
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Setup Items and Default Values

Communication (Ethernet) > E-Mail > System settings
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1
Recipient 2

On/Off
On/Off

Off
Off

Include source URL
Subject
Header 1
Header 2

On/Off
32 characters or less
64 characters or less
64 characters or less

Off
System_warning
–
–

Communication (Ethernet) > E-Mail > Report settings
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1
Recipient 2

On/Off
On/Off

Off
Off

Include source URL
Subject
Header 1
Header 2

On/Off
32 characters or less
64 characters or less
64 characters or less

Off
Report_data
–
–

Communication (Ethernet) > FTP client > FTP transfer file
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
FTP transfer file > Disp&Event data
FTP transfer file > Report
FTP transfer file > Snapshot

On/Off
On/Off
On/Off

Off
Off
Off

Transfer wait time > Disp&Event data*2

Transfer wait time > Report*2
0 to 120 min
0 to 120 min

0
0

With /AS1*3

FTP transfer file > Disp&Event data On/Off Off
FTP transfer file > Report On/Off Off
FTP transfer file > Snapshot On/Off Off
FTP transfer file > Setting On/Off Off
The Transfer wait time items are the same as on a DX without the /AS1 option.

Communication (Ethernet) > FTP client > FTP connection
Setup Item Selectable Range or Selections Default Value Setting
FTP connection Primary/Secondary Primary
FTP server name 64 characters or less –
Port number 0 to 65535 21
Login name 32 characters or less –
Password 32 characters or less ******...***
Account 32 characters or less –
PASV mode On/Off Off
Initial path 64 characters or less –

Communication (Ethernet) > SNTP client
Setup Item Selectable Range or Selections Default Value Setting
SNTP client > Use/Not Use/Not Not
SNTP client > Server name 64 characters or less –
SNTP client > Port number 0 to 65535 123
SNTP client > Access interval Off/1h/8h/12h/24h 8h
SNTP client > Access reference time 00:00 to 23:59 00:00
SNTP client > Access timeout 10s/30s/90s 30s
SNTP client > Time adjust on Start action On/Off Off
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Setup Items and Default Values

Communication (Ethernet) > Modbus client > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Basic settings > Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Basic settings > Retry interval Off/10s/20s/30s/1min/2min/5min/10min/

20min/30min/1h
2min

Communication (Ethernet) > Modbus client > Modbus server settings
Setup Item Selectable Range or Selections Default Value Setting
Server number 1-8/9-16 1-8
Port
Modbus server name
Unit
No.

0 to 65535
64 characters or less
Auto/Fixed
0 to 255

502
–
Auto
1

Communication (Ethernet) > Modbus client > Command settings
Setup Item Selectable Range or Selections Default Value Setting
Client command number 1-8/9-16 1-8
1 to 16
First
Last
Server
Regi.
Type

Off/R/R-M/W/W-M/E-M*3

Depends on the command type.
Depends on the command type.
1/2/3/.../15/16
Numerical value
INT16/UINT16/INT32_B/INT32_L/UINT32_B/
UINT32_L/FLOAT_B/FLOAT_L

Off
–
–
1
30001
INT16

Communication (Ethernet) > Modbus client > Auto settings
Automatically assigns MW100s to the DX.

Communication (Ethernet) > Password management > KDC connection (/AS1 option)*3

Setup Item Selectable Range or Selections Default Value Setting
KDC connection Primary/Secondary Primary
KDC server name 64 characters or less –
Port number 0 to 65535 88

Communication (Ethernet) > Password management > Certification key (/AS1 option)*3

Setup Item Selectable Range or Selections Default Value Setting
Host principal 20 characters or less –
Realm name 64 characters or less –
Password 20 characters or less –
Encryption AES128/AES256/ARC4 AES128
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Communication (Serial) > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Baud rate 1200/2400/4800/9600/19200/38400 9600
Data length 7/8 8
Parity Odd/Even/None Even
Handshaking Off:Off/XON:XON/XON:RS/CS:RS Off:Off
Address 1 to 99 1
Protocol Normal/Modbus/Modbus-M Normal
With /AS1*3

The baud rate, data length, parity, handshaking, address items are the same as on a DX without the /AS1 option.
Protocol Normal/Modbus/Modbus-M/Barcode Normal

Communication (Serial) > Modbus master > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Timeout 125ms/250ms/500ms/1s/2s/5s/10s/1min 1s
Retrials Off/1/2/3/4/5/10/20 1
Inter-block delay Off/5ms/10ms/15ms/45ms/100ms Off
Auto recovery Off/1min/2min/5min/10min/20min/30min/1h 2min

Communication (Serial) > Modbus master > Command settings
Setup Item Selectable Range or Selections Default Value Setting
Master command number 1-8/9-16 1-8
1 to 16
First
Last
Addr.
Regi.
Type

Off/R/R-M/W/W-M/E-M*3

Depends on the command type.
Depends on the command type.
1 to 247
Numerical value
INT16/UINT16/INT32_B/INT32_L/UINT32_B/
UINT32_L/FLOAT_B/FLOAT_L

Off
–
–
1
30001
INT16

Communication (PROFIBUS-DP)*2

Setup Item Selectable Range or Selections Default Value Setting
Node Address 0 to 125 3

Setup Items and Default Values



94 IM 04L42B01-02E

Status relay*3

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Fail relay Fail/Status relay Fail
Status relay Fail/Status relay Status relay
With /AS1
Fail relay Fail/Status relay/Mem. sample/Invalid user/Login Fail
Status relay Fail/Status relay/Mem. sample/Invalid user/Login Status relay

Status Relay > Status Relay Details*3

Setup Item Selectable Range or Selections Default Value Setting
Memory/Media status On/Off Off
Measurement error On/Off Off
Communication error On/Off Off
Memory stop On/Off Off
Alarm*2 On/Off Off

Set Calibration*3

Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Notification 1 to 10 1
Renotification 10min/30min/1h/8h/24h 1h

End
Setup Item Selectable Range or Selections Default Value Setting
Do you want to store and 
make the new settings take effect?

Yes/No/Cancel –

Setup Items and Default Values
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File/Initialize tab*2

Load settings
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Load settings > Kind CF/USB CF
Initialize > Kind Clear 1/Clear 2/Clear 3 Clear 3
Media eject CF/USB –
With /AS1*3

Load settings > All settings > Kind CF/USB CF
Load settings > Login info only > Kind CF/USB CF
Load settings > Other settings > Kind CF/USB CF
Initialize > Kind Clear 1/Clear 2/Clear 3/Clear 4 Clear 3
Media eject CF/USB –

End
Setup Item Selectable Range or Selections Default Value Setting
Do you want to store and 
make the new settings take effect?

Yes/No/Cancel –

Setup Items and Default Values
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